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Notices
This information was developed for products and services offered in the U.S.A and other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that only
that IBM product, program, or service may be used. Any functionally equivalent product, program, or
service that does not infringe any IBM intellectual property right may be used instead. However, it is the
user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document.
The furnishing of this document does not grant you any license to these patents. You can send license
inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS”
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore,
this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication. IBM
may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part
of the materials for this IBM product and use of those Web sites is at your own risk. IBM may use or
distribute any of the information you supply in any way it believes appropriate without incurring any
obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
5 Technology Park Drive
Westford Technology Park
Westford, MA 01886

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this information and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement, or
any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated
through extrapolation. Actual results may vary. Users of this document should verify the applicable data
for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only. All IBM prices shown are IBM's suggested retail prices,
are current and are subject to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to change before the
products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

Trademarks

These terms are trademarks of International Business Machines Corporation in the United States, other
countries, or both:

 IBM

 Kenexa

 BrassRing

 Onboard

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or
its affiliates.

Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States, other
countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or both.

Other company, product, or service names may be trademarks or service marks of others.
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Admin – Candidate Account Retrieval Tool

This feature allows IBM® Kenexa® BrassRing® on Cloud Admin+ users to retrieve candidates’ BrassRing Talent
Gateway account details and to reset candidate passwords. Clients no longer need to request Help Desk
assistance to reset candidate passwords.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

LDP 142

 BrassRing

 Talent Gateways

Workbench Self-Service

Visible Changes  No – requires specific conditions / configuration for visibility.

How do I get this feature?  Configuration required – contact our Support Team for
implementation details.

Feature Description
Candidates frequently need assistance recovering their Talent Gateway (TG) account login details. Currently, if
the self-service tools (forgot password/forgot username) do not provide clients or candidates with the details
they need, the client must call the BrassRing Help Desk in order to reset candidate passwords. This feature
allows privileged BrassRing users to retrieve account details and reset candidate passwords.

BrassRing administrative users with Candidate Account Retrieval privileges access the Candidate Account
Retrieval tool via a new Admin+ menu selection. This menu selection launches the Admin +: Candidate Account
Retrieval page allowing BrassRing administrative users to access candidate TG login details using either a
candidate's username/email address, or, if the candidate has applied for a requisition, first and last name.
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BrassRing User Experience

BrassRing users with the Candidate Account Retrieval privilege can use the Account Retrieval Tool to view and
reset TG login candidate passwords.

This feature does not support wildcard searching; search results display only exact
matches.

In the BrassRing application, BrassRing administrative user:

1. Navigates to Admin > Admin+ > Candidate Account Retrieval.
The Admin+ Candidate Account Retrieval page launches.

2. On the Admin+: Candidate Account Retrieval page, BrassRing administrative users can search for
candidates using a candidate's username/email address or, if the candidate has applied for a requisition, a
candidate's first and last name. The search option you choose determines the workflow. Select your search
option, username/email address OR First and last name.

For accounts with "Allow any unique login string" selected for TG login type client
setting, you must specify the username rather than candidate's contact email address
(or use the First name and Last name lookup option).

For accounts with "Email address only" selected for TG login type client setting, you
must the login email address (or use the First name and Last name lookup option).

Account Retrieval Tool - username/email address:

BrassRing administrative user:

3. Enters candidate's username or email address and clicks Get Account Details.
Text field supports up to 255 characters.

The Account Details Search Results Page re-launches with full account details.

If the Search Results displays multiple candidates meeting the search requirements:

 Click the radio button to select a singular candidate and click Get Account Details.
The Account Details Search Results Page re-launches with full account details for the selected
candidate.
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 Verify the candidate's identity by asking security questions before resetting password or releasing any
candidate information. If information is not correct:

Deselect the candidate and re-select the next candidate and repeat the verification process.

4. Verifies the candidate's identity by asking security questions before resetting password or releasing any
candidate information.

5. Clicks Reset Password to reset the candidate's password.
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The Account Details Search Results Page re-launches with a randomly generated new password.

6. BrassRing user conveys new password to candidate.

7. Clicks Close.

Account Retrieval Tool – First and Last Name

To retrieve by first and last name, the candidate must have applied for a requisition. BrassRing administrative
user:

3. Enters the candidate's first and last name and clicks Lookup.
The Admin+: Candidate Account Retrieval page re-launches with the search results.

4. Selects the candidate and clicks Get Account Details.

The Account Details Search Results Page re-launches.

5. If the Search Results displays multiple candidates meeting the search requirements:

 Clicks the radio button to select a single candidate and clicks Get Account Details.
The Account Details Search Results Page re-launches with full account details for the selected
candidate.
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 Verifies the candidate's identity by asking security questions before resetting password or releasing any
candidate information.
If verification responses provided by candidate are not correct:

o Deselects that candidate and selects the next candidate

o Repeats the verification process (click Get Account Details, ask candidate security questions
before resetting password or releasing any candidate information.
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6. Once a candidate’s identity is verified, clicks Reset Password to reset the candidate's password.

The Account Details Search Results Page re-launches with a randomly generated new password.

7. BrassRing administrative user conveys new password to candidate.
8. Clicks Close.

Limitations and Known Issues

The Account Retrieval Tool retrieves only one candidate's account information at a time.

How Do Clients Get this Feature?
This feature is controlled by an enhanced client setting and a new user privilege. Please contact our Support
Team or your Certified Workbench User for more information.
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Configuration Tasks

This feature is controlled by an enhanced client setting and a new BrassRing user type privilege.

Client Settings – Workbench (Support Staff)
Use this procedure to enable the Enhanced self-service login management and Account Retrieval Tool setting.

In Workbench:

1. Admin > Manage Clients > Edit Client Settings or click the pencil edit icon.
The client settings dialog box displays.

2. Scroll to TG Login details management setting and select the radio button for 'Enhanced self-service login
management and Account Retrieval Tool'.

3. Click Save.

User Type Privileges – Workbench Self-Service (Tiers 1+)
BrassRing users must have the Candidate Account Retrieval privilege to access the Account Retrieval Tool
within the BrassRing Application.

1. Tools > Users > User types.
2. Select the user and click the pencil icon for Edit type permissions.

The Set Name Function dialog box launches.
3. Click the pencil icon for the Admin+ privileges.
4. Check the checkbox for Candidate Account Retrieval.

5. Click Done.
6. Click Save.
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Candidates – Mobile Apply Enhancements

Three new features are now available for IBM
®

Kenexa
®

BrassRing
®

on Cloud Mobile Apply: Forgot Login
Name, IBM

®
Kenexa

®
Assess

®
on Cloud Assessments, and Share Job via Email.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

LDP 109

 BrassRing

 Talent Gateways

Workbench Self-Service

Visible Changes  No – requires specific conditions / configuration for visibility.

How do I get this feature?  Configuration required – contact our Support Team for
implementation details.

Feature Description
This release of Mobile Apply introduces new features designed to support a more integrated BrassRing
workflow and a redesigned Edit view of the Profile contact tab. Candidates applying for jobs via Mobile Apply
can now:

 retrieve their Login Name (username) using the Forgot Login Name function
 access their Assess assessments
 send friends jobs via email from the Job Details page

IBM
®

Kenexa
®

Prove It!
®

On Cloud assessments are not currently supported on mobile
devices.

Feature List
The following is an introduction to Release 13.4 Mobile Apply features. Each list item is an active link to a brief
description of that feature including abbreviated configuration instructions.

Please contact your Support Team for more information enabling these features:

 Forgot Login Name
 Access Assess Assessments
 Send Friend job via Email

Forgot Login Name
Mobile-optimized BrassRing Talent Gateways (TG) now supports the Forgot Login Name function allowing
candidates to retrieve their Username via a "Forgot Login Name" option. When the Mobile Apply Forgot Login
Name function is enabled:

 The login page displays a “Forgot Login Name?” hyperlink. When tapped, this hyperlink displays a Forgot
Login Name page in a separate browser allowing the user to retrieve the username by providing answers to
all three security questions.

 For candidates that do not have three security questions saved to their profile already, a new “Add Security
Questions” page is displayed when they log into their account. Candidates need to provide answers to all
three security questions and save those answers before proceeding with the application or saving a job to
the cart.

 All three Security Question widgets display a list of ten security questions; five are existing and five are new.
 Registration pages now display three security questions.
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The Forgot Login Name workflow is not mobile-optimized. Candidates can retrieve
Login Name but they may have to zoom and scroll during the retrieval process.

Candidate Experience

When this feature is enabled, Candidates can retrieve their Login Name on Mobile Apply.

1. Candidate lands on the Mobile Apply Login Screen.

2. Taps Forgot Login Name? Hyperlink.

Forgot Your Username? screen launches.
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3. Candidate enters First and Last Name and Home Phone or Email address and taps Submit.
The security question screen launches. The following screen displays when candidates do not have any
security questions saved to their BrassRing Talent Gateway profile.

4. If Candidate does not have any Security Questions associated with their BrassRing Talent Gateway profile,
they must select a Security Question for each of the three fields and enter an answer to the question. If the
Candidate only has one Security Question saved, they must add the additional Security Questions.

If the Candidate does have three Security Questions associated with their BrassRing Talent Gateway
profile, they must correctly answer three existing security questions and Save those questions. On Mobile
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Apply, the Security questions display in an abbreviated format. For example, instead of the Security
Question, "What is your Favorite Restaurant" Mobile Apply displays "Favorite Restaurant."

Right Answers

When the candidate taps Submit, a window launches if the entered data matches the stored data. The
window displays the username that matches the submitted information for 90 seconds, then closes
automatically (can tap Close to close manually).

Wrong Answers

If submitted answers do not match in their entirety the first and second times, the following error message is
raised: “Please try again.”

If the third submission also fails, the message configured for your “Username retrieval unsuccessful
message” BrassRing TG text customization setting displays to the candidate.

5. Taps Save.
6. Mobile Apply workflow continues.

How Do Clients Get this Feature?

This feature if configured via a client setting, TG login details management. Please contact your Kenexa
Support Team for more information about enabling this feature.

Assessments for Mobile Apply
Candidates can now complete IBM Kenexa Assess assessments during the job application process using
Mobile Apply. When this feature is enabled, Candidates can retrieve Assess assessments during the Mobile
Apply application process.

Assess assessments are supported on Mobile Apply but are not mobile optimized.

IBM
®

Kenexa
®

Prove It!
®

On Cloud assessments are NOT currently supported on
mobile devices.

Candidate Experience

During the job application workflow, candidates can now access IBM Kenexa Assess assessments.

1. Candidate submits their job application via Mobile Apply and lands on the Confirmation page.

15 of 186



Copyright IBM Corp. 2014 Candidates – Mobile Apply Enhancements | 5

2. Candidate taps Continue.
3. Candidate lands on the pending assessments page. All assessments associated with the requisition (job)

display. Each pending assessment is identified with a Req ID, Job Title, and a Status indicator of "In
Progress" or "Not Started."

The pending assessments page might display a mobile logo, text customization for the “Assessment Page
Title," or both depending on the client's configuration. If configured, customized text configured for the
pending assessment page displays here.

4. Candidate can tap the right arrow for each individual assessment to complete the pending assessments or
tap Done to complete assessments at a later time.
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If req is configured with hurdling and candidate does not successfully complete the assessment, a candidate
is directed back to a blank pending assessment page.

The Mobile Post Confirmation Page, displays acknowledging the submission.

If configured, the candidate lands on the Mobile Post Confirmation page URL defined
in Workbench. If not URL is configured, the candidate lands on the Talent Gateway
logged-in page.

5. Candidate taps Done.

Mobile-optimized Assess Assessments on mobile devices are accessible only during
the Mobile Apply workflow. Candidates who do not complete assessments during the
Mobile Apply job application workflow can return to the mobile assessments page at a
later date, but the mobile device does not display the mobile-optimized assessment
workflow. Assessments not completed during the Mobile Apply workflow can be
completed via the desktop.

Best Practice Recommendations

Clients who have both IBM Kenexa Prove It! Assessments and IBM Kenexa Assess assessments configured for
a requisition are advised not to enable this feature, as IBM Kenexa Prove It! assessments are not supported on
Mobile Apply.

How Do Clients Get this Feature?

This feature is configured via a BrassRing Talent Gateway setting, Allow Launching of Assessments from
Mobile Apply. Please contact our Support Team for more information about enabling this feature.

Send Friend Jobs via Email
Candidates can now share jobs via email from Mobile Apply similar to the functionality of the "Send to Friend"
feature on BrassRing Talent Gateways.

If the BrassRing Talent Gateway has both mobile optimization enabled and "Send to a Friend" enabled, then the
Mobile Apply job details page displays the Share button. Tapping the Share button allows the candidate to
share the job via email with one or more friends.
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The Share button does NOT support sharing jobs via social networks.

Candidate Experience

During a job search using Mobile Apply, candidate lands on a Job Details page and finds a job they would like to
share. Candidate:

1. Taps the Share button.
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The Job Share via Email page launches.

2. Enters their email address in the From field, the Recipient's email and name in the Recipient Email and
Name fields.

3. Taps Add.
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The Job Share via Email page Re-launches with a selected checkbox and the Recipients name. If a
candidate wishes to cancel the sending of the email, the candidate can tap to remove the check mark and
cancel the send.

4. Taps Add to add additional Recipients or taps Send to send emails.

If the number of additional Recipients exceeds the vertical screen space, the list becomes vertically
scrollable.

Recipients (friends) receive an email displaying:

 subject line containing the default or customized text (configured for the Send to Friend subject line on the
TG Job Details page in Workbench)

 message containing customized tokens (sourced from Workbench) that include links to the recommended
job posting(s)

 Tapable View details link to view and apply to job.
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Customized Send to Friend message text can be configured for BrassRing TGs in
Workbench.

How Do Clients Get this Feature?

This feature is controlled by a special configurations setting, Disable Send to a Friend, which must be
unchecked in Workbench. Talent Gateway text customization for the TG offers flexible messaging. Please
contact our Support Team or your Certified Workbench User for more information.
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Configuration Tasks

This section describes the tasks required to configure these features. Tasks labeled Workbench Self Service
can be performed by certified Workbench Self Service users or by our support staff.

Configuring Forgot Login Name
If clients have the Forgot Username feature configured for BrassRing Talent Gateways, Mobile Apply Forgot
Login Name uses those settings for the Forgot Login Name workflow. The only difference is that on Mobile
Apply, the Security questions display in an abbreviated format. For example, instead of the Security Question,
"What is your Favorite Restaurant" Mobile Apply displays "Favorite Restaurant."

Steps to set up this feature include for Talent gateways:

1. Set TG login details management client setting.
2. Check that Activate security question(s) for client settings are set appropriately.
3. Customize text on the TG Notifications tab for the Username retrieval unsuccessful message, as desired

(Tools > Talent Gateways > Text customization link [for selected TG] > Notifications tab > Username
retrieval unsuccessful message). Workbench Self-Service (Tiers 1+)

4. Update custom text on the TG Create Login tab for Create login intro text , if necessary (Tools > Talent
Gateways > Text customization link [for selected TG] > Create Login tab > Create login intro text).
Workbench Self-Service (Tiers 1+)

Client Settings – Workbench (Support Staff)

BrassRing Workbench Support Staff:

1. Navigates to Client Settings and clicks the Edit icon –OR– Admin > Manage Clients > Edit client
settings.

2. Selects Enhanced self-service login management for TG login details management.

3. Clicks Save.

Enhanced self-service login management - New self-service capability for candidates accessing Mobile
Optimized Talent Gateways via Mobile Apply.

 Requires the selection of 3 security question/answer pairs.
 Includes a longer list of abbreviated security questions.
 Provides "Forgot Login Name" for candidates accessing job application workflow via Mobile Apply.

Allow Launching of IBM Kenexa Assessments
The TG setting, "Allow Launching of IBM Kenexa Assessments from Mobile Apply," must be enabled for
pending assessments to launch during the Mobile Apply workflow.
In addition, an existing BrassRing Workbench TG setting “Launch Assessments via Continue button” for the TG
must be enabled in order for the Continue button to display on the Confirmation page for both BrassRing TG
and Mobile Apply workflows.

The following steps to set up this feature include:

1. Enable "Allow Launching of Kenexa Assessments from Mobile Apply" and "Launch Assessments via
Continue button" Talent Gateway Settings.

2. Configure Text Customization for Mobile Apply for the Assessments page text – no assessments pending
page.
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BrassRing Talent Gateway Settings – Workbench Self-Service (Tiers 5+)

Enable Allow Launching of Kenexa Assessments

To enable this feature, BrassRing Workbench Self-Service (WBSS) user:

1. Navigates to Workbench > Tools > Talent Gateways > Add/Edit [selected TG].
2. Selects the checkbox for Allow Launching of Kenexa Assessments from Mobile Apply.

3. Selects the checkbox for Launch Assessments via Continue button.

4. Clicks Save.

Talent Gateway Text Customization – Workbench Self-Service (Tiers 1+)

Text Customization for Assessments Pending Page

You can use this procedure to customize the Assessment page summary text.

1. Workbench > Tools > Talent Gateways > Select your Gateway and click the Edit Text.
2. Scroll to the Landing Logged In tab.
3. Enter text for Assessment page summary text. This customized text displays on the pending assessment

page.
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4. Click Save.

Send Friends Jobs via Email
The following steps to set up this feature include:

1. Check the "Disable send to a Friend" Talent Gateway Setting.
2. Configure Text Customization for Mobile Apply if client does not have text customization configured.

Disable Send to a Friend TG Setting – Workbench Self-Service (Tiers 5+)

Ensure "Disable send to a Friend" TG setting is NOT enabled:

1. Navigates to Workbench > Tools > Talent Gateways > Edit [selected TG].
2. Unchecks the "Disable send to a Friend" Talent Gateway setting in the “Special configurations” section, if

necessary.

3. Clicks Save.

Talent Gateway Text Customization – Workbench Self-Service (Tiers 1+)

Text Customization for Mobile Apply Send to Friend

To customize text associated with the Send to Friend Mobile Apply functionality, enter customizations on the TG
Job details tab and the TG Notifications tab.

1. Workbench > Tools > Talent Gateways > Edit Text [for selected TG]
2. Scroll to the Job details tab.
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3. Enter up to 250 characters in the Send to friend E-mail Subject text box on the Job details tab. This
customized text displays in the email subject line. Click the Reset to Default button to restore default text:
[#jobtitle#] at [#clientname#].

4. (Optional) Enter text customization for the Send to Friend button text.
5. Navigate to the Notifications Tab and enter text customization for Send to Friend Email text.

6. Click Save.
7. Click Synchronize changes with Talent Gateways.
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CK Editor

Clients can now enable the CK Editor 4.2.2 for use in IBM
®

Kenexa
®

BrassRing
®

on Cloud communication
modules and on formatting-enabled text area type requisition fields. The CK Editor produces structurally clean
HTML tags, and supports a number of languages and spell-check utilities.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

LDP 209

 BrassRing

Visible Changes  No – requires specific conditions / configuration for visibility.

How do I get this feature?  Configuration required – contact our Support Team for
implementation details.

Feature Description
When the CK Editor is enabled, it is available for use on many communication module pages and on
formatting-enabled requisition fields of the text area type. The CK Editor is a widely-used open source HTML
text editor that supports an extensive formatting toolbar and produces structurally clean HTML tags, important
for displaying HTML pages correctly in different browsers.

When enabled, the CK Editor is available on the following pages in BrassRing:

 Add blurb | Edit blurb
 Add communications template | Edit communications template | Send communication (email)
 Add document template | Edit document template | Create document
 Add document packet template | Edit document packet template | Send communication (document packet)
 Add system e-mail template | Edit system e-mail template
 Formatting-enabled requisition fields: Job Description, Requisition Notes, and custom text area fields on

pages where reqs are added or edited

Target users are BrassRing communications administrators who create blurbs and templates; BrassRing users
who create and post requisitions.

BrassRing User Experience
When this feature is enabled, BrassRing users see the CK Editor functionality when the blurb or template
displays. The example below shows the editor in use within an HTML-based document template.

1. Navigate to Admin > Communications > Add document template.
2. Select HTML editor option and clicks Go.

The document template screen displays with CK Editor's formatting toolbar.

To create formatted content in the CK editor, use one of these methods:
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 Enter text directly into the editor and use the formatting buttons on the toolbar to format the content.
 Copy and paste formatted content from Word using the Paste button. The CK editor creates HTML markup

that does a reasonable job of reflecting the formatting used in Word.
 Create HTML content in an external HTML editor and copy and paste the source code into the Source code

window of the CK editor within BrassRing. Use this method to get the most sophisticated results.

3. Completes all required document template fields.
4. Clicks Save.

Using the CK Editor and Formatting Toolbar
When using the formatting toolbar in the CK Editor, the beginning and ending tags for your content are created
automatically. You don’t have to pay attention to them. Similarly, if you create content in an external HTML
editor, the CK Editor automatically creates the tags correctly (as long as it is not an older editor from several
years ago).

Formatting Tool Bar

When the CK Editor is enabled and BrassRing users select an HTML document or document template workflow,
the CK Editor functionality and toolbars display. The CK Editor has an extensive formatting tool bar.

Formatting Tool Bar – First Row

The following table describes the formatting options of the first row of the formatting tool bar:

Button Tool Tip Description

Paragraph Format Select text and apply any of the following paragraph formats.
Built in formats are:

 Normal: Default Font Face is Arial 12
 Heading 1
 Heading 2
 Heading 3
 Heading 4
 Heading 5
 Heading 6
 Formatted: Font face is Courier New
 Address
 Normal (div)

Font Name Select text and apply any of the following font names:

 Arial (default)
 Comic Sans MS
 Courier New
 Georgia
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Button Tool Tip Description

 Lucida Sans Unicode
 Tahoma
 Times New Roman
 Trebuchet MS
 Verdana

Font Size Select text and apply a font size from 8 to 72. Default is 12.

Bold Select text and apply bolding.

Italic Select text and Click the button to apply italics.

Underline Select text and Click the button to apply underline.

Remove Format Select text and Click the button to remove existing formatting.

Find and Replace

1. Enter the term to find in the ‘Find:’ box.

Select ‘Find Options’ if applicable.

Find Options

Match case: Unchecked by default. The search finds only those
terms that match in case for every character in the search term.

Match whole word: The search looks only at whole words that
match the search term. Example: When Match whole word is
checked and the search term is: "option", you will find all
instances of "option", but not the words "optional" or "options".
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Button Tool Tip Description

Match cyclic: Checked by default. When checked, when the CK
editor search reaches the end of the document, it cycles back to
the beginning of the document and continues the search.

2. Enter the replacement term in the ‘Replace with’ box.
3. Click Find. The search will go to the first instance of the term

to be found.
4. If applicable (meaning you want to replace the found term

with something else), click Replace to replace the term in
the first instance. Click Replace All to replace all instances
of the term.

Text Color Select text and Click the button to launch color picker window.
Select desired color. Color is applied to the selected text.

Background Color Click the button to launch color picker window. Select desired
color. Color is applied to the page.

Check Spelling Click the button to launch the spell check window. The utility
highlights all “suspicious” words and lists suggestions for them.

The options are Replace, Replace All, Skip, Skip all.

Decrease Indent Place cursor in line or select text and Click the button. Text is
moved to the left if it is not already at the left margin of the page.

Increase Indent Place cursor in line or select text and Click the button. Text is
moved to the right.

Align Left Place cursor in line or select text and Click the button. Text is
moved to the left margin of the page.

Align Center Place cursor in line or select text and Click the button. Text is
moved to the center of the page.

Align Right Place cursor in line or select text and Click the button. Text is
moved to the right margin of the page.

Align Justified Place cursor in line or select text and Click the button. Text is
aligned on both left and right margins.
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Formatting Tool Bar – Second Row

The following table describes the formatting options of the second row of the formatting tool bar:

Button Tool Tip Description

Left-to-right Place cursor in line or select text and Click the button. Text reads from
left to right.

Right-to-left Place cursor in line or select text and Click the button. Text reads from
right to left.

Numbered List Select list item(s) and Click the button. A number is applied to it.
Numbering continues until you select s new style, such as Normal.

Bulleted List Select list item(s) and Click the button. A bullet is applied to it. Bullets
continue until you select s new style, such as Normal.

Cut Select text and/or other item(s) added to the page and Click the button.
The selected text or item is removed.

Copy Select text and/or other item(s) added to the page and Click the button.
The selected text or item(s) are copied to the clipboard.

After copying content (either within the editor window or from an
external source):

 Click Paste to retain source formatting
 Click Paste as plain text to strip source formatting

Undo After an action has been taken, Undo button becomes enabled. Click
left-pointing arrow to undo the last action.

Redo After clicking Undo, the Redo button becomes enabled. Click right-
pointing arrow to redo an action that was undone.

Select All Click the button to select all content in the editor window.

Insert Special
Character

Click the button to insert a special character [!@#$%^&*(), accented
letters, trademarks, and so forth].

To add a special character:

5. Place the cursor in location of special character.
6. Click the button to launch a window listing special characters.
7. Click the special character you want to add to the text.
8. The special character appears where your cursor is.

Insert Image Click the button to insert an image or to create an image link. Enter the
URL (web address) for the image. Images must be hosted in a location
where the blurb, template, generated document, document packet, or
email can reach them.
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Button Tool Tip Description

Insert Link If using an image as a button, select Link.

Insert Document
Bookmark

Click the button to insert a bookmark before a word or title. Insert a
bookmark if you want to link to it from another location on the page or
from another page. If linked in this way, all pages must be in the same
directory.
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Button Tool Tip Description

Bookmark is inserted; you can now create a link to this bookmark from
within the same document.

Insert Page Break Click the button to insert a page break indicator where the page should
break and cick the button. The page break is inserted in the HTML
page.

URL Link To add a link to another page or Website:

1. Enter the correct URL for the site or page to which you want to link.
‘http://’ is understood.

2. Enter the Link Text. This is the text the viewers and recipients see
instead of the URL. You can place the URL in this box if desired.

3. Click OK.

The link is created.

Insert Table Click the button to open the Insert Table configuration window.

The default table size is 3 rows and 2 columns of fixed size, and a total
table width of 500 pixels.

You can change any of these attributes.

Insert Horizontal Line Place the cursor in the location where the horizontal line should be
inserted and click the button.

Create Div Container Click the button to insert a DIV container at the cursor position.

Blockquote Click the button to indent and center a paragraph, for example a long
quotation.
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Button Tool Tip Description

Show Blocks Click the button to display block elements on the HTML page. Each
block element starts on a new line and has a space above and below
it. This shows the structure of the document.

New Page Click the button to create a brand new page.

Print Click the button to launch Print dialog box.

Maximize Click the button to expand editor window.

Formatting Tool Bar – Third Row

Button Tool Tip Description

Click the Source button to view the HTML source code for
the content in the CK Editor.

For example, the CK Editor displays Rich Text as shown here.

Clicking the Source button displays the HTML Source Code.
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Accessibility Help – Lower Right Hand Corner

When using the CK Editor, you can use ALT + 0 to launch CK Editor navigation accessibility instructions. For
example, when you press ALT + 0, the CK Editor Accessibility Instructions dialog box launches. Use the scroll
bar to learn more about navigation and Shortcut Keys.
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Best Practice Recommendations

Recommendations are to enable the CK Editor in staging and select some representative templates and blurbs,
and make note of potential anomalies. If existing representative templates have been altered to work around
anomalies of the FCK and YUI editors, the altered HTML might not render properly in the CK Editor's
WYSIWYG view or preview windows.

A guide to CK Editor was posted on the URC for clients in January, 2014 and updates will be ongoing. You will
be able to move back and forth between CK Editor and legacy HTML editors until late in 2014, at which time the
legacy editors will be sunset. IBM will send out repeat notifications and guidelines in preparation for this
migration.

The two existing HTML editors (Classic and YUI editor) will be available until the end of 2014. Your organization
should plan to migrate templates, blurbs, and Job Descriptions to the CK Editor.

For more detailed and up-to-date information regarding the CK Editor, refer to the BrassRing CK Editor Guide
on the User Resource Center (URC) via Home > Product Information > BrassRing > User Guides and
References.

Limitations and Known Issues

Due to a configuration setting of the CK Editor, the editor adds an extra line between paragraphs by default.
BrassRing Engineering has changed the value for this configuration setting and will release the fix to Staging
and Production on the 18

th
of February 2014.

Engineering is investigating the following issues:

 The ability to create links to external sites using the link button.
 The ability to create and link to anchor tags (Doc bookmarks) within the same document.
 The ability to upload an image to be included with the communication.

Supported Languages

The CK Editor supports all BrassRing supported languages as noted in the document, Languages Supported in
BrassRing on the User Resource Center (URC).

How Do Clients Get this Feature?
The CK Editor is enabled by a new Workbench Client Setting. Please contact our Support Team for more
information.
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Configuration Tasks

This section describes the tasks required to configure this feature. Tasks labeled Workbench Self Service can
be performed by certified Workbench Self Service users or by our support staff.

Client Settings – BrassRing Workbench (Support Staff)

BrassRing Workbench

This feature is enabled via a BrassRing Workbench Client Setting:

1. Navigate to Client Settings and clicks the Edit icon –OR– Admin > Manage Clients > Edit client settings.
2. Click the Yes radio button for Enable CKEditor.

3. Click Save.
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Communications – New Merge Token

A new merge token, TG Username, is now available for use in email communications.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

RDP 671

 BrassRing

Visible Changes  Yes – details in Visible Changes document.

How do I get this feature?  Automatic – see details below.

Feature Description
A new merge token is added to the Communications “Candidate Fields” variable group. In candidate
communications, this merge token adds the Talent Gateway user name of the candidate to whom the
communication is addressed. The following are the pages in which this new merge token is available:

 Add | Edit blurb.
 Save as new blurb.
 Add | Edit communications template – Email template section
 Send communication (email)

BrassRing users with Administrative privileges and privileges to create and edit communication templates view
this new merge token automatically.

BrassRing User Experience

BrassRing users can use the new merge token in email communications by adding it from the Merge Fields
multi select box.
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The new merge token is: [#Contact-info:TalentGatewayUserName#].

Candidate Experience

Candidates see their BrassRing Talent Gateway profile user name in the email communication if this token is
added in the communication template used.

Limitations and Known Issues

If the candidate’s user name is not available in the Talent Record or if the candidate does not have a BrassRing
Talent Gateway profile, no information is returned by this merge token.

How Do Clients Get this Feature?
This feature is available automatically without configuration.
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Communications – Posting Offer Letters to Candidate
Portal

IBM® Kenexa® BrassRing® on Cloud users can now post candidate offer letters directly to the Candidate Portal
Page using the Create Document or Create Document Packet workflow.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

RDP 718

 BrassRing

 Talent Gateways

Workbench Self-Service

Visible Changes  No – requires specific conditions / configuration for visibility.

How do I get this feature?  Configuration required – contact our Support Team for
implementation details.

Feature Description
BrassRing users can create and post offer letters to a Candidate Portal via the create document or create
document packet workflow.

BrassRing users must have the Candidates – Post to Candidate Portal user type permission and associated
Communication privileges to use this feature.

BrassRing User Experience

BrassRing users with the required privileges can create offer letters via the create document workflow and post
them to the Candidate Portal Page. Although not shown in this workflow, BrassRing users can also post
document packets containing offer letters.

To Post an offer letter to the Candidate Portal, BrassRing user navigates to a req folder:

1. Selects candidate and selects Action > Create Document.
2. Selects document template and creates the offer letter.

Document template must have the 'Allow posting to Candidate portal’ attribute
enabled.

3. Completes all template fields and selects the checkbox for Allow Posting to Candidate portal attribute.
4. Generates the offer letter.
5. Clicks Save as PDF.

The Create document confirmation page launches.
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6. Clicks Go to post offer letter to the Candidate Portal.

The Post to Candidate Portal page launches and the Offer Letter Document is preselected in the
Standalone section.

7. (Optional) Selects and adds attachments or candidate forms as desired. However, BrassRing users cannot
add additional documents as a part of this workflow.

8. Clicks Post to Candidate Portal.

If a BrassRing user searches within the documents (generated through Create
Document) on the Post to Candidate Portal page, the default offer letter document
becomes unavailable.
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The Post to Candidate Portal Confirmation page launches displaying detailed posting information.

When items post to the Candidate's portal, detailed posting information is updated on the following pages:

Candidate portal posting history
Talent Record Attachments grid
Talent Record Action Log

9. Clicks List >> on the Post to Candidate Portal Page to select an email communication template to send to
candidate.
The email template displays:
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10. Completes the email template and clicks Send.
The following logs are updated:

Action Log
Communications History

42 of 186



© Copyright IBM Corp. 2014 Communications – Posting Offer Letters to the Candidate Portal | 5

If the save correspondence option on the email template is set to yes, a hyperlink to
the email is saved and can be launched from the Communication History grid and the
Actions Log.

11. Clicks Close on the Portal Confirmation.
12. (Optional) Clicks the Posting History hyperlink on the Candidate Portal Page.

The page reflects the posting history of the currently selected candidate.

Posting History hyperlink is only available when posting for one candidate. If posting to
multiple candidate portals, the Posting History link is grayed out

13. Clicks Close to close the Portal History Page.

Limitations and Known Issues

This feature is supported only for the Create Document and Document Packets workflows. No Post to
Candidate Portal option displays on the Attachments Confirmation page.

How Do Clients Get this Feature?
This feature is controlled by a user type privilege, Candidates – Post to Candidate Portal, in Workbench. Please
contact the BrassRing Support Team or Certified Workbench User for more information.

Using this feature requires that clients:

 Enable the existing user privileges associated with this feature
 Configure the Send Communication workflow
 Ensure templates and users belong to org groups
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Configuration Tasks

Client Settings – Workbench (Support Staff)
Two client settings control the Candidate Portal Posting Page workflow.

 ‘Candidate Portal - Append expiration date to the links of posted documents and document packets’ controls
the visibility of the expiration date on links to documents and document packets posted on the Candidate
Portal: The default for this setting is set to Yes.

 'Allow Communications template selection on Candidate Portal posting confirmation pages' controls the
visibility of the option to select a communications template on the 'Post to Candidate Portal Confirmation'
and 'Document Packet Posted' confirmation page. The default for this setting is set to Yes. The settings to
select the communications template on the confirmation pages display by default and clients must set the
client setting to No to hide them.

Candidate Portal – Append expiration date to the links of posted documents and document
packets

Use this setting to hide the expiration date on the links for documents and document packets on the Candidate
Portal. The default for this setting is set to Yes.

In Workbench:

1. Admin > Manage Clients > Edit Client Settings.
The client settings dialog box displays.

2. Click the No radio button for Candidate Portal – Append expiration date to the links of posted documents
and document packets.

3. Click Save.
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(Optional) Client Setting – 'Allow Communications template selection on Candidate Portal
posting confirmation pages'

Use this optional procedure to hide the visibility of the option to select a communications template on the 'Post
to Candidate Portal Confirmation' and 'Document Packet Posted' confirmation page. The default for this setting
is set to Yes.

In Workbench:

1. Admin > Manage Clients > Edit Client Settings.
The client settings dialog box displays.

2. Click the No radio button for 'Allow Communications template selection on Candidate Portal posting
confirmation pages.'

3. Click Save.

User Type Privileges – Workbench Self-Service (Tiers 1+)
BrassRing users must have the Candidates – Post to Candidate Portal privilege and associated Communication
privileges to post offer letters to the candidate portal.

1. Workbench > Tools > Users > User types > Edit type permissions.
The set name function dialog box launches.

2. Click the pencil icon for Candidate Actions 3.
The Candidate 3 Actions dialog box launches.

3. Check Candidates – Post to Portal checkbox.
4. Click Done.
5. Click the pencil icon for Communications.

The Communications dialog box launches.

Check the associated communication privileges to support this workflow.

 Communications – enable
 Create document – enable
 Document templates – add
 E-mail templates – add
 View all stored communication history

For document packets, restrict or allow these specific Communications privileges:

 Document packet – edit preconfigured subject
 Document packet – send
 Document packet – view
 Document packet templates – add

6. Click Done.
7. Click Save.

If Document Packet posting privileges are not selected, the Candidate Portal Posting
Page displays only the Post Standalone items section.
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Communications – Send from Preview

This feature provides users with the option of sending a candidate communication from the preview window
directly.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

RDP 670

 BrassRing

Visible Changes  Yes – details in Visible Changes document.

How do I get this feature?  Automatic – see details below.

Feature Description
BrassRing users with the privilege to send candidate communications have an option of previewing the
communication they have drafted. User clicks “Preview” in the communication screen, which opens a new
window with the preview of the communications. This preview window now features a new Send button, using
which users can send the communications directly without closing the preview and going back to the
communications screen.

BrassRing User Experience

Path: Req panel/Req folder > select single candidate or multiple candidates > Actions > Send Candidate
Communication > select Communications template > Go > Send communication (Email message) > Preview
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Users draft candidate communications from the Send Communication screen. This screen has a button
Preview at the bottom along with Send and Cancel.

When users click Preview, a new window with the preview of the candidate communication is displayed.

Previously, after previewing the draft, users had to close the preview window and send the communication from
the Send Communication Screen. With the current feature, users have a new option.

Clicking Send from the preview window sends the communication to the candidate. A confirmation message is
displayed along with the names of the candidates to whom the communications were sent.

Best Practice Recommendations

When you select multiple candidates for sending a communication, you can navigate through all of them using
the arrow link at the top of the preview window. Clicking Send in any one of the candidates’ previews sends the
email to all of the candidates that are selected. Therefore, it is a best practice to preview the communications for
all of the candidates before you click Send.

How Do Clients Get this Feature?
This feature is available automatically without configuration.
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Communications – Update HR Status Links

This IBM
®

Kenexa
®

BrassRing
®

on Cloud feature allows BrassRing users to update a candidate's HR Status
when posting to the Candidate Portal and Document Packet Posted pages via an Update HR Status link on the
posting confirmation pages.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

RDP 893

 BrassRing

 Talent Gateways

 Workbench

Visible Changes  No – requires specific conditions / configuration for visibility.

How do I get this feature?  Configuration required – contact our Support Team for
implementation details.

Feature Description
BrassRing users can now update a candidate's HR Status when posting standalone items (attachments,
documents, candidate forms) to the Candidate Portal and Document Packet Posted pages via an Update HR
Status for successful candidate(s) link on the Posting Confirmation pages.

In order to access and use this feature once configured, BrassRing users must have
the following existing user privileges:

 Communications > Document packet - send
 Candidate Actions 3 > Candidates – Post to Candidate Portal

In conjunction with these privileges, BrassRing users must have the corresponding
Candidate Action privileges to update the req and the HR status associated with a
particular candidate.

BrassRing User Experience

When configured, BrassRing users can now click the Update HR Status for successful candidates Link on
the Post to Candidate Portal Confirmation and the Post Document Packet Confirmation pages.

When using either the Post to Candidate Portal or the Posting Document Packet (Send
Communication) action for multiple candidates, selected candidates must be in the
same req, working, or inbox folder and must all have the same HR status.

Posting to the Candidate Portal

The following outlines the experience of a BrassRing user using the Post to Candidate Portal action.

BrassRing user:

1. Selects one or more candidates from within a req folder.
2. Clicks Post to Candidate Portal.

Candidate Portal Page launches.

3. Selects one or more items to post or clicks Display all if only one candidate was selected for this action.
4. (Optional) Selects a posting removal date.
5. Clicks Post to Candidate Portal.

The Post to Candidate Portal page launches.
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6. Selects documents for selected candidate and clicks Post to Candidate Portal.

Post to Candidate Portal Confirmation page launches:

7. Clicks Update HR status for successful candidate(s) link.

HR Status Update page launches and displays candidate name, current HR status, and a list of potential HR
statuses.

8. Selects the HR Status, and Clicks Update. (Optional) Deselects candidate if necessary.

Candidate HR Status Update confirmation page launches.

9. Clicks Close.
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10. Clicks Close.

Posting Document Packets (Send Communication)

The following outlines the experience of a BrassRing user using the Send Communication Action and with the
client setting "Allow Communications template selection on Candidate Portal posting confirmation pages"
enabled.

BrassRing user:

1. Selects one or more candidates from within a req folder.
2. Clicks Post to Candidate Portal.

Candidate Portal page launches.

3. Selects a document packet template and clicks Create a Document Packet.

Send communication page launches.

4. Completes all Document Packet fields and uploads documents as required.
5. Clicks Post to Candidate Portal.

Document Packet Posted Confirmation page launches.

If "Allow Communications template selection on Candidate Portal posting confirmation
page" is set to Yes, BrassRing users can notify candidates of postings via
preconfigured communication templates on the Document Packet Posted Confirmation
page.

6. Clicks Update HR status for successful candidate(s) link.

HR Status Update page launches and displays candidate name, current HR status, and a list of potential HR
statuses. Document Packet Posted Confirmation Page remains open.
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7. Selects the HR Status and Clicks Update. (Optional) Deselects candidate if necessary.

Document Packet Posted Confirmation Page is still open.

8. Selects a communications template and clicks Go.

The Send communication page launches for the selected email template and the existing Send
Communication workflow continues.

Limitations and Known Issues

This feature is not available from the confirmation message generated when BrassRing users post a generated
document to the Candidate Portal from the attachments grid.

How Do Clients Get this Feature?
This feature is controlled by a new client setting. Please contact your Support Team for more information about
enabling this feature.
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Configuration Tasks

This section describes the tasks required to configure this feature. Tasks labeled Workbench Self Service can
be performed by certified Workbench Self Service users or by our support staff.

Client Settings – Workbench (Support Staff)
Use this procedure to enable the Add HR Update Status Links to the Candidate Portal and the Document
Packet Pages.

In Workbench:

1. Admin > Manage Clients > Edit Client Settings or click the pencil edit icon.
The client settings dialog box displays.

2. Scroll to Allow HR status update link on Candidate Portal posting confirmation pages and select the
Yes radio button.

3. Click Save.
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Cultural Changes – Date Format Customization

With this feature, IBM® Kenexa® BrassRing® on Cloud administrators can select date formats based on the user
locales. BrassRing users see the date in the system based on the configured date format specific to the locale.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

LDP 148

 BrassRing Workbench Self-Service

Visible Changes  No – requires specific conditions / configuration for visibility.

How do I get this feature?  Configuration required – contact our Support Team for
implementation details.

Feature Description
BrassRing users see dates in several screens during their regular activities with candidates and requisitions.
Having the date displayed in the format associated with their own locale makes the product more useful for
them. Date formats used in various locales are now available so that administrators can configure a preferred
format for a locale. After this configuration, all users who have that locale see the date in their configured format.

All BrassRing users with system access view the dates in the configured format wherever date is displayed (as
read-only). Following are some of the examples where the users see date in the configured format:

 All candidate panels on Home Page where date field is displayed.
 All requisition related screens where date fields are displayed in read-only format.
 Any Microsoft Excel file created using the “Export Grid” functionality if it contains date as a part of the grid.
 Communications pages that display date in read-only format.

BrassRing User Experience

Date is displayed to users in various screens based on the format configured for their locale.

Following is the “My Candidates” panel from the BrassRing Home screen that has Chinese as locale and the
date format for that locale is set to a Chinese date format.
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Following is the All Open Reqs panel with the Chinese locale:

Best Practice Recommendations

When a BrassRing administrator selects a specific date format for each of the locales in Workbench, the same
format is applied across BrassRing in all pages where there is a date field in view or read-only mode for the
applicable locale. As this configuration changes the date format across all users based on the users’ locale,
administrators should be cautious while making configuration changes.

Limitations and Known Issues

BrassRing screens that have candidate-facing pages, such as email communications and blurbs, do not display
the locale-based date format. This new feature is limited to the BrassRing pages that are user-facing only.

The system will not prompt the users or the administrators regarding the date change when the locale for the
user is changed. An administrator must configure the required date format for it to be displayed.

How Do Clients Get this Feature?
This feature is controlled by a new UI setting in Workbench settings.

Please contact our Support Team or your Certified Workbench User for more information.
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Configuration Tasks

This section describes the tasks required to configure this feature. Tasks labeled Workbench Self Service can
be performed by certified Workbench Self Service users or by our support staff.

Workbench Settings – Workbench Self-Service (Tiers 1+)
A new locale-level configuration, Select a date format, is provided on the Edit customized UI locale screen.

Tools > Settings > Language and locale customization > 2xB UI Locale name customization > Edit
customized UI locale

The Dropdown list provides all the date formats for each selected locale. When you select the date format for
the locale here, all the users that have the locale in their BrassRing user profile see the same format.

Note: The system will use the preexisting default date format assigned to that locale if
you do not select any specific format from the list provided.

55 of 186



© Copyright IBM Corp. 2014 Data Insight Tool – Enhancements | 1

Data Insight Tool – Enhancements

Several ease-of-use and performance enhancements have been made to IBM® Kenexa® BrassRing® on Cloud
Data Insight Tool.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

LDP 218

 BrassRing  Data Insight Tool

Visible Changes  Yes – details in Visible Changes document.

How do I get this feature?  Automatic – see details below.

Feature Description
Several ease-of-use and performance enhancements have been made to IBM® Kenexa® BrassRing® on Cloud
Data Insight Tool. Enhancements include:

 Delimiter option for Data Insight Tool reports
 Higher maximum for filter criteria
 More efficient handling for duplicate-scheduled reports
 Fine-tuning for time-zone conversion features

Delimiter Option

Users can now choose the delimiter in their Data Insight output reports. In certain circumstances, they can also
choose character encoding format for their output. Options are available when they:

 Create a new template
 Edit a template
 Copy a template
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Reports > Data Insight Tool > Manage Templates > Create New | Edit | Copy Template

In the Template Output section:

For Delimited by field, you can select:

 Tab (default delimiter)
 Comma

When Delimited by delimiter is set to Comma, you can select Character Encoding format:

 Unicode (default format, used automatically when Tab is the delimiter)
 ANSI (certain Unicode characters may not display correctly when ANSI is select)

Filter Criteria

The maximum number of criteria users can select for a filter has been raised to 200 from 50 (Reports > Data
Insight Tool > Manage Templates> Create New | Edit | Copy Template > Template Identity > Template
Workshop > Filter Worksheet). Users can also choose between Starts With and Contains for searches they
want to perform when providing filter criteria in the “Filters Worksheet.” This helps users provide precise criteria
for extracting a report that they need from the Data Insight Tool.
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In addition, since reports that have no criteria selected or too many criteria take a long time to run; a warning
messge will be displayed when a report is created with:

 No filter selected (Message “No filters selected. Report generation may fail or be delayed. Do you want to
continue?” displays as pop-up. Click OK to close and proceed with template creation/editing.)

 More than 50 criteria selected (Message “*Note: More than 50 criteria selected. Report generation may be
delayed” displays at top of window.)

Duplicate Schedules

There will be no UI changes for this feature; only implementation.

As part of this implementation, DIT will check if the template has already been run and if the report has been
generated in the current transformation. If yes, then DIT will send user the details of that report instead of
running and creating a new report again. If no, then DIT will run and create the report for the template.

In case, the schedule is found to have multiple instances of the same templates queued at almost same time ;
then DIT will move the duplicate schedule to the end of the queue. When the duplicate template has to be run,
then again DIT will check for instances of created report and send the details.

Time Zone Conversion

Gaps in an earlier iImplementation of time-zone conversion features in Data Insight have been addressed.
Rules for time zone conversion are:

 Time zone displays only if the Time/Date Display by user’s Time Zone client setting is enabled.
 Time zone is based on the user’s time zone unless otherwise specified (overwrite feature).
 Time zone indicator appears in brackets beside the date and/or time fields.
 Time zone is based on uniform standard time.

Data Insight Administrators:

 Can create the report in their time zone. Time zone will display in the column header in the report output.
 Can overwrite their existing time zone by using the “Default time zone” feature (see section 4.5 below). Time

zone will display in the column header in the report output.

For Data Insight users, the date and/or time fields reflect the time zone in which the report was created.

DIT Report Recipients

 Receive the report in the time zone in which the report was created.
 See the time zone in which the report was created displayed in the header column in brackets.

To prevent the display of incorrect data, time zone conversion has been reverted (is no longer applied) to certain
fields, such as custom form fields like Date of Birth. Conversion could have the undesired effect of moving a
birth date to a different day, such as from 09 May 1996 to 10 May 1996. that should always remain the same.
The following table includes date fields that where time zone conversion will no longer be applied.
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Candidates Reqs

 All Form fields (Custom fields)
 Date Req Posted (on gateway)

 Date/Time of Interview (scheduled date and time)
 Planned Removal Date (from gateway)

 Date/Time requested (for interview)
 Actual Removal Date (from gateway)

 Date/Time updated (for interview)

How Do Clients Get this Feature?
These enhancements are available automatically without additional configuration.

Note: If a client account is inactivated, all schedules are automatically suspended. If an inactive client is made
active again; then all the templates and schedules are activated and the reports will be generated based on their
previously created schedules.
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Event Manager - Enhancements

Several new features were added to Event Manager for Release 13.4. These features are also documented in
the Event Manager Administrator's Guide and Event Manager User's Guide.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

LDPs 211, 216, 221
RDP 715

 BrassRing

 Event Manager

Workbench Self-Service

Visible Changes  Yes – some new changes are documented in the Visible Changes
document sent for each release build.

How do I get this feature?  Configuration required – contact our Support Team for
implementation details.

Feature Description
This release of Event Manager introduces new features designed to support a more integrated BrassRing/Event
Manager workflow. Event Manager Administrators (EM Admin) and Event Manager Users (EM Users) can now
access the following features:

 EM Admins can configure the automatic adjustments of candidate slots when assessors are added or
removed from event time slots

 EM Admins can now manage candidate slots and overbooking limits in multiple events within an event
series from the Event Summary landing page

 Event Manager Assessors (EM Assessors) can now email their event schedules and iCalendar files via the
My Schedule page

 EM Admins can now configure an automatically generating event reminder Assessor Reminder Email
Message

Feature List
The following is an introduction to Release 13.4 Event Manager features. Each list items is an active link to a
brief description of that feature including abbreviated configuration instructions.

For in depth feature information refer to Event Manager Administrator's Guide and the Event Manager User's
Guide.

Please contact your Support Team for more information enabling these features:

 One-on-One Interview Event Type (211)
 Open Candidate Slots (216)
 Assessor Email Self-Service (221)
 Assessor Reminder Messages (715)

One on One Interview Event Type
A new event template attribute, One-on-One Interview Event Type, allows EM Admins and Users to create
events that enforce a 1:1 ratio between the number of scheduled assessors and the number of candidate slots
(Max Candidates). Previously, EM Admins had to manually monitor assessor schedules and manually adjust
candidate slots accordingly.

Events created from event templates configured with this attribute:

 always have the same number of scheduled assessors and candidate slots
 automatically update to maintain the 1:1 ratio between scheduled assessors and candidate slots when

assessor schedules or cancels out of a scheduled time slot
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When this attribute is configured, the Max Candidates value for a time slot on both
event template and event configuration page will be a non-editable value and defaults
to 0.

For example, in events configured with this attribute, if an assessor schedules themselves for a time slot, the
number of candidate slots (Max Candidates) increases by one. If an assessor cancels from a scheduled time
slot, the number of candidate slots (Max Candidates) decreases by one.

Event Manager cannot decrease the number of candidate slots (Max Candidates)
below the number of scheduled candidates. If candidates are scheduled for a particular
time slot, assessors cannot cancel their scheduled time slot and Admins cannot delete
the assessor from the time slot manually.

If it is necessary to cancel an assessor's scheduled time slot, Admins must reschedule
candidates to other time slots or schedule a second assessor to the time slot before
removing the original assessor.

Event Manager Administrator Experience

When events are created from event templates with the One-on-One Interview Event Type attribute enabled,
EM Users can create new (or edit existing events) created from these templates.

EM Admin or EM User navigates to the New/Edit Event page via the Scheduled Event, Event Summary, or
Event Search pages:

1. Clicks the plus (+) symbol on the Event Time Slot tab to launch the New Time Slot dialog box.
2. Clicks Add to add a new time slot.

The time slot dialog box launches.

The Candidate Slot (Max Candidates) value cannot be edited directly for One-on-One
Interview events. It can be adjusted only by adding or removing assessors (manually
or self-scheduled) to/from the time slot.

There is no change in this functionality for overbooking limit for 1:1 events.

3. Completes all the required fields for the Time slot.
4. Clicks Save.

This event template attribute is not supported for Availability Only events.
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How Do Clients Get This Feature?

A new Event template attribute setting supports the One-on-One Interview Event Type attribute. Events created
from event templates with this attribute selected inherit the attribute and its functionality.

In Event Manager –Template Settings (EM Admins and EM users with Super User or Event Template privileges)

1. Navigates to Admin > Templates > New/Edit Event Template.

The event template page launches.

2. Selects the checkbox for One-on-One Interview Event Type.

3. Completes required event template configuration fields.
4. Clicks Save.

Save as New

If an EM users creates a new event from the One-on-One Interview Type event using the ‘Save as New’ action,
then the New Time Slot page for the new event should hide the ‘Max candidates’ field. Default values for ‘Max
candidate’ per time slot and ‘Slots Remaining’ per time slot for the new event will depend upon the selection of
‘Copy assessors’ and ‘Copy candidates’ fields on the ‘Events: Save Event as New’ pop up page while creating
the new event from the selected event.

If the user selects ‘Copy assessors’ checkbox from the ‘Events: Save Event as New’ pop up page and does not
select the ‘Copy candidates’ checkbox, then then new One-on-One Interview event will have:

 Assessors scheduled per time slot/assessor shift in the selected event copied over to the new event
 ‘Max candidates’ and ‘Slots remaining’ values per time slot will be equal to the number of the assessors

scheduled for the time slot and are saved in the database accordingly.
 Slots remaining value for the event will be equal to the total of ‘Max candidates’ value for all of the time slots

for the event and saved accordingly.
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If the user selects ‘Copy candidates’ checkbox from the ‘Events: Save Event as New’ pop up page, then the
‘Copy assessors’ checkbox will be selected by default and grayed out until the user unselects the ‘Copy
candidates’ checkbox. When the user unselects the ‘Copy candidates’ value, then the ‘Copy assessors’
checkbox will become active but will remain as selected until the user unselects it.

The new One-on-One event created with ‘Copy candidates’ and ‘Copy assessors’ selected will have:

 Assessors scheduled per time slot/assessor shift in the selected event copied to the new event.
 ‘Max candidates’ value per time slot will be copied from the selected event to the new event and will be

saved accordingly.
 ‘Slots remaining’ per time slot as well as for the entire event will be copied from the selected event to the

new event and saved accordingly.
 Candidates scheduled per time slot in the selected event copied to the new event.

If the user does not select either ‘Copy candidates’ or ‘Copy assessors’ checkboxes, then the new One-on-One
Interview event will have:

 ‘Max candidates’ value for the time slots will be ‘0’ by default as assessors and candidates from the selected
event are not copied over to the new event.

 ‘Slots remaining’ per time slot and event will display and save in the database as ‘0’ by default.

Open Candidate Slots
A new Action on the Event Summary Action menu, Open Candidate Slots, allows EM Admins to update the
number of candidate slots within individual events or multiple events within an event series. If the overbooking
feature is enabled, EM Admins can update overbooking limits using the Open Candidate slots action.

The Open Candidate Slots feature supports:

 Updating of shared (common) candidate time slots across events in a series
 Updating of all time slots within an event that is either a standalone event or part of

an event series
 Overbooking feature that can adjust the buffer action

Event Manager Administrator Experience

Event Manager Administrator accesses the Event Summary page:

1. Selects an event (or multiple events) in an event series.
2. Clicks the Action > Open Candidate Slots.

The Open Candidate Slots dialog box launches.

Singular event selections display all times slots for that particular event.
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Multiple event selections display all time slots common across the selected events.

The time slot grid lists all the time slots shared across all the selected events that are
part of the same event series. Time slots that have the same Time Slot Name, Time
Slot Start and Time Slot End across the selected events in an event series are listed
on the time slot gird. If any of the three attributes are different, then those time slots will
not display on the time slot grid.

3. Selects the Candidate Slots to be updated.
4. Enters the New Max Candidate value in the text field for all the selected slots.
5. (Optional) Enters the overbook limit for all selected slots.
6. Clicks Save.

The selected time slots within the selected events are updated with the new values.

If an Event Administrator enters a new Max Candidates value that is less than the number of already scheduled
candidates, an error displays preventing the update to proceed and displays the time slots that cannot be
updated. All other selected time slots are updated.

How Do Clients Get This Feature?

In Event Manager –System Settings (EM Admins)

A new Systems > General setting supports this feature and is enabled by default. To disable this new feature,
EM Admin:

1. Navigates to Admin > General > Systems page.
The Systems > General page launches.

2. Clicks the No radio button for the Open Candidate Slots from Event Summary.

3. Clicks Save.

Limitations and Known Issues

Open Candidate Slots feature is not supported for one-on-one interview slots.

Assessor Email Self-Service
A new Email button option on the Assessor's My Schedule page and the My Schedule/Event Pop-up dialog box
allows assessors to email their event schedules and iCalendar files to themselves and to other email recipients.
From the My Schedule page assessors can email day, week, or month schedule views in a pdf format and
include iCalendar files for scheduled consecutive assessor shifts to update their Outlook™ calendars. From the
My Schedule/Event Pop-up dialog box assessors can email detailed event schedule views for individual events
and include iCalendar files to update their Outlook™ calendars.

Event Manager Assessor Experience (Emailing Schedule Views and iCalendar files)

Assessor wants to send the detailed scheduled for January to his Outlook email ID so that he can view it outside
of Event Manager and block his time on his Outlook calendar.
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Assessor views his January calendar schedule that includes two events in the month of January on January 11
th

for the Onsite Interview Day for the following shifts:

9:00 a.m. - 10:00 a.m.
10:00 a.m.- 11:00 a.m.
1:00 p.m. - 2:00 p.m.
2:00 p.m. - 3:00 p.m.

And, assessor is also scheduled for the Phone Screen event on January 14
th

for the following shifts:

12:00 p.m. - 12:30 p.m.

12:30 p.m. - 1:00 p.m.

1. Assessor navigates Events > Assessor Scheduling > My Schedule.

My Schedule page launches and displays the January month view. Alternatively, assessors can select the
month, day, or week views.

2. Assessor clicks the Email button.

The Email dialog box launches and the assessor's email address displays in the To field.

3. Assessor:

 accepts his/her email address –
 (Optional) enters a semi-colon and enters additional email address in the To: field
 (Optional) enters new text in the Subject field
 clicks Yes radio button to include iCalendar files
 clicks Yes radio button to include schedule PDF file
 (Optional) enters text in the Message field.

4. Clicks Send.
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The assessor receives the email containing the following iCalendar files:

January 11
th
:

 Onsite Interview Day: 9:00 - 11:00
 Onsite Interview Day: 1:00 - 3:00

January 14
th
:

 Phone Screen: 12:00 - 1:00

Assessor can double-click each iCalendar file to update his Outlook calendar.

The pdf file is a month view of the My Schedule page, in this case January that the assessor can open and print.

Event Manager Assessor Experience (Emailing Detailed Schedule and iCalendar files)

Assessor wants to receive iCalendar files of his event commitment timeline to block time on his Outlook
calendar and a detailed event schedule in order to view it outside of Event Manager.

Assessor is registered for two assessor shifts on January 10
th

and wants to block his time on his Outlook
Calendar:

 9:00 a.m. - 12:00 p.m.
 3:00 p.m. - 5:00 p.m.

1. Assessor navigates Events > Assessor Scheduling > My Schedule.

My Schedule page launches and displays the month view.

2. Assessor clicks a specific event instance within the January Calendar month view.
The Event dialog box displays:
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3. Assessor then clicks the Email button.

The Email dialog box launches and the assessor's email address displays in the To field.

4. Assessor:

 accepts his/her email address

 (Optional) enters a semi-colon and enters additional email address in the To: field

 (Optional) enters new text in the Subject field

 clicks Yes radio button to include iCalendar files

 clicks Yes radio button to include Detailed schedule

 (Optional) enters text in the Message field

5. Clicks Send.

The assessor receives the email.
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The assessor receives the email containing the following iCalendar files:

January 11
th
:

 9:00 - 12:00
 3:00 - 5:00

Assessor can double-click each iCalendar file to update his Outlook calendar and view the detailed schedule for
the selected event.

Limitations and Known Issues

Emails containing assessor iCalendar files are not sent in a cumulative format. In other words, iCalendar files
represent consecutive time frames within a particular event and a separate iCalendar file is sent for each
non-consecutive time frame. For example, if an assessor schedule contains four non-consecutive time slot
commitments for an event, four iCalendar files are sent. If an assessor emails themselves iCalendar files for
multiple days, Event Manager emails an iCalendar file for each non-consecutive time slot for each event.
Recipients must open each individual iCalendar file in the received email in order for their Outlook calendar to
update.

How Do Clients Get This Feature?

This feature is enabled by default and requires no configuration.

Assessor Reminder Messages
EM Admins can now configure events to automatically generate and send assessor email reminder messages.
Assessor reminder messages can be sent to manually or self-scheduled assessors. Email reminder messages
reminds assessors of their commitment and allows them to cancel in a timely manner if they need to do so.

During event configuration, EM Users configure assessor reminder messages on the Messages tab.

Assessor reminder messages also support the following message functionality:

 Event specific message tokens including [em_event_template_name], [em_event_name],
[em_event_series_name], [em_event_descriiption], [em_event_reruiter_name], [em_event_schedule],
[em_event_date], [em_event_location], [em_event_owner_name], and [em_assessor_schedule, etc.])

 The eLink token for the specific assessor’s My Schedule page [em_assessor_reg_link]
 iCalendar files (all iCaldender files)
 Event Schedule PDF files

The default Assessor Reminder message can originate from the event template or from the system setting if an
event is configured not using an event template. EM Users can also edit the Assessor Reminder Message
content during event creation and set a number of days before events for reminder messages to be sent.

Assessor Reminder Messages do NOT support candidate related message tokens
(candidate schedule, candidate self-schedule registration link, time slot start, time slot
end, candidate name, invitation expiration date and days, and minimum slots available
token) nor Requisition Merge Fields.

Event Manager User Experience

With this feature enabled, an EM User creates a new event and configures the event to send Assessor
Reminder Messages. On the Event Summary screen, EM User:

1. Navigates to Actions > New to create a new event.
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2. Selects an event template and clicks Continue.

The Events: New Event page launches.

3. Completes all event configuration fields, including Event date (January 10) and event start and end times
(one for 9 am to 12 pm shift and one for other for 3 pm to 5 pm shift).

4. Clicks the plus symbol (+) on the Messages tab.
5. Selects the message template for Assessor Reminder Messages and sets the day before event value to 2

day before event.

6. Clicks the Edit Message hyperlink.

The Send Message screen launches

7. EM User edits Assessor Reminder Message, selects iCalendar files for consecutive assessor shifts, and a
pdf of the event schedule by assessor.

8. Clicks Save.
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The Send Message screen refreshes.

9. Selects the number of day before event to send Assessor Reminder Message.

Best practice is to select a timeframe that allows the EM Admins sufficient time to react if the assessor
receives the reminder message and decides to cancel out of their event commitment.

10. Clicks Save to Single Event.

Assessor signs for this event on January 10
th

for two consecutive shifts 9 a.m. to 12 p.m. and 3 p.m. to 5 p.m.

 Assessor receives the configured email two days before the event date if two days is configured as number
of days before event to send the reminder message.

 Assessor receives two iCalendar files, one for the 9 am to 12 pm shift and other for the 3 pm to 5 pm shift,
and message text with values for any message tokens used.

Assessor can open the iCalendar file and save it to his/her Outlook calendar to block his time.

If assessor cannot make it to the event, he can access the My Schedule page using the assessor registration
link added in the message and cancel out of the event.

 Assessor history is updated with the details of the communication.

How Do Clients Get This Feature?

In Event Manager – System Settings (EM Admins)

A new Systems Notification Default, Assessor Reminder Message, enables the Assessor Reminder Messages
feature on event templates and event messages. EM Admins can accept default reminder messages or
configure specific reminder message templates.

EM Admin:

Navigates to Admin > System > Notifications page.

The Systems > Notifications page launches.

1. Navigates to the Default Assessor Reminder Message field that defaults to N/A indicating that the feature is
disabled and clicks the drop-down menu to select a message template for the reminder message.

EM Admin can select None or any message template configured for the client in Event Manager with the
“Assessor Send Email” category. Selecting None means that events can be still be configured with
assessor reminders, but there are no default assessor reminders.

2. Clicks the drop-down menu to select the number of days before the event to send the reminder messages.

Best practice is to select a timeframe that allows the EM Admins sufficient time to react if the assessor
receives the reminder message and decides to cancel out of their event commitment.

3. Clicks Save.

EM Admin can optionally configure the iCalendar Consecutive Assessor Shifts option so EM Users can select
this option on the edit Send message page and send assessors an iCalendar file to update their Outlook
calendars. This option is available only when the assessor self-scheduling functionality is turned on and works
only for Availability and Assessor Shift events.
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1. (Optional) EM Admin navigates to Admin > List Maintenance > iCalendar files.
The Admin: iCalendar page launches.

2. Clicks New to create a new iCalendar file.

The Admin: iCalendar file configuration page launches.

3. Selects the radio button for 'Consecutive Assessor Shifts' in the Create iCalendar files for option.

4. Completes all iCalendar configuration fields.
5. Clicks Save.
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Gateway Questionnaires – Communications Widgets

Two new Gateway Questionnaire widgets are available for use in different candidate communications scenarios.

One widget is designed to capture candidate communications preference. The other widget captures the mobile
phone country when SMS messaging is turned on for the client. Clients might want to add one or both of these
widgets if they:

 use a Gateway Questionnaire to collect candidate profile information.
 elect to turn on the feature "SMS messaging."
 elect to turn on the feature "Candidate communications preference."

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

RDP 993b Release 13.3
RDP 993c Release 13.4

 BrassRing

 Talent Gateways

Workbench Self-Service

Visible Changes  No – requires specific conditions / configuration for visibility.

How do I get this feature?  Configuration required – contact our Support Team for
implementation details.

Feature Description
Two new widgets are available for use on the Contact Information page of the Gateway Questionnaire (GQ).

Mobile phone country: This GQ widget allows candidates to select their mobile phone country on the GQ. This
is used to prepend the country dialing code to the candidates’ mobile phone number if necessary at time of
sending an SMS message.

Communications preference: This GQ widget collects information in a GQ regarding email preferences of a
candidate.

When should these widgets be used?

If a client enables SMS messaging and uses a GQ to collect candidate profile information, users that set up
Gateway Questionnaires (GQ) should consider adding the Mobile phone country widget to a position near the
Other phone (i.e. mobile) field on the Contact information page of the GQ.

There are several variations to communications preference.

By default, the system communications preference is HTML email.

Using the WB setting "Candidate communications preference," a client can turn on functionality that lets a
candidate express the following combinations of communications preferences.

 Text email instead of HTML email (the default)
 SMS messages instead of email messages (the default) for short alerts and communications.
 Both preferences together: Text email (rather than html email) and SMS messages (instead of either text or

HTML email).

If a client wishes to capture the communications preference of the candidate for any of the above combinations,
users that set up GQs should add the Candidate communications preference widget to the Contact Information
page of the GQ.
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Candidate Experience

Candidates that apply to a requisition with a GQ associated or candidates that submit a generic application
without a specific job, will now have additional fields in which they provide their communication preference.
Based on the clients’ choices, candidates either see or do not see some of the widgets.

Candidate Communication preference

In the following figures, the first displays only email format preferences while the second also displays SMS
preference field to the candidates. This is dependant upon the settings choice made in Workbench by the client.

Depending on the choice of the clients, the following are the options that can be made available for the
candidates in all combinations:

 Email – HTML format only (default)
 Email – Text format only
 Email (HTML) and SMS
 Email (Text) and SMS

Mobile Phone Country

A single-select dropdown box is available for the candidates to choose their country. This page should also
contain the “Other phone number” widget where candidates submit their mobile phone number. Based on the
country information, the country’s telephone country code is prepended to the candidate’s mobile phone number
when SMS is sent to candidates.

How Do Clients Get this Feature?
This feature is controlled by specific configuration. Please contact your Kenexa Support Team for more
information.
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Configuration Tasks

This section describes the tasks required to configure this feature. Tasks labeled Workbench Self Service can
be performed by certified Workbench Self Service users or by our support staff.

1. Set client settings.
2. Add GQ widgets. They can be added to the GQs depending on the client settings.

Client Settings – Workbench (Support Staff)
Client setting: Candidate communication preference

Workbench > Select a client > Edit
–OR–
Workbench > Admin > Manage Clients > Edit client settings [for selected client]

 To continue behavior of not displaying preference options, select only “Email Format – HTML.” This makes
neither of the two new GQ profile question widgets available for display on the GQ, and provides email in
HTML format since “Email format – HTML” is the default selection.

 To make the new GQ question widget “Communication Preference” available for display on the GQ so that
candidates can select an email format preference between text and HTML, select “Email Format – HTML”
and “Email format – Text.”

 When “SMS” is enabled for the client, to make both new GQ question widgets available for display on the
GQ so that candidates can select text or email as their communication preference, select all three options:
“Email format – HTML,” “SMS,” and “Email format – Text.” With this configuration, candidates have the
option to choose among Email (Text or HTML) and/or SMS.

In spite of having both the client settings enabled, it is not mandatory for a client to
have either of the widgets on a particular GQ. They may still have some GQs without
any of the Communication Preference widgets while all three options above are
selected.

Gateway Questionnaire Widgets – Workbench Self-Service (Tiers 0+)
The new widgets must be added to the GQs for the candidates to access them. Workbench Self-service users
can save an existing GQ as new, add the new widgets and activate the new GQ. Depending on the client’s
choice, either of the widgets, both of the widgets, or neither of the widgets can be added to the GQ.

You can add the Candidate communication preference widget or the Mobile phone country widget to the
profile page.
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Tools > Gateway Questionnaires > Add new Gateway Questionnaire / [select existing draft] > Administer
sections/pages > Administer widgets/ Add new widget

Candidate communication preference widget

 Widget type = Question
 Question source = Contact information fields
 Field = Communication Preference
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Mobile phone country widget

 Widget type = Question
 Question source = Contact information fields
 Field = Mobile phone country

Note: When the Mobile Phone country widget is added to a GQ, the “Other Phone
number” widget must also be available on the same page of the GQ. If the Mobile
phone country widget is added to a GQ and saved without the “Other phone number”
widget being available on the same page, an error message is displayed.
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Integrations – Background Check Vendor Updates

Updates for background check integrations with IBM® Kenexa® BrassRing® on Cloud Release 13.4 include:

 New vendor: Verified Credentials
 Availability of 1-step integration with Orange Tree

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

RDPs 881, 1034

 BrassRing  Integrations – Background Check

Visible Changes  No – requires specific conditions / configuration for visibility.

How do I get this feature?  Configuration required – contact our Support Team for
implementation details.

Feature Description
Updates for background check integrations with IBM® Kenexa® BrassRing® on Cloud Release include:

 New vendor: Verified Credentials
 Availability of 1-step integration with vendor Orange Tree

Verified Credentials

Verified Credentials is now available to clients as a vendor for background check integration with BrassRing.
This is a 2-step integration, where BrassRing users are redirected to the Verified Credentials application when
they set a candidate to the triggering HR status.

For more information about Verified Credentials, Inc, you can see their website: www.verifiedcredentials.com

Orange Tree

Previously offering a 2-step integration with background check vendor Orange Tree, BrassRing now has
available a 1-step integration with Orange Tree. In a 1-step integration, BrassRing users pre-select packages for
their req so that when they set a candidate to the triggering HR status, BrassRing submits the request in the
background in a format that satisfies the vendor application data requirements. The candidate’s basic status and
results are updated within the preconfigured BrassRing standard candidate results form, and detailed results
become available through link back to the vendor from that results form.

For more information about Orange Tree, you can also see their website: http://www.orangetreescreening.com

BrassRing User Experience

The following shows a sample user experience for a 1-step integration.
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1-Step Integration: BrassRing User Selection of Package Associated to Job

1-Step Integration: HR Status Update Kicks off Order Request
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1-Step Integration: Resultsfrom Vendor Accessed through BrassRing Results Form

The process for a 2-step integration is similar, but the triggering HR status update send the user to the specific
vendor’s site, where the user selects the background check service or package.

Viewing results when the check is complete is the same for both processes.

How Do Clients Get this Feature?
Background check integrations are controlled by integration subscription settings and field mapping. Please
contact our Support Team or your Certified Workbench User for more information.
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Configuration Tasks

The following summarizes the steps to configure 1-step integration. Setup for 2-step is similar. For complete
information, see the internal Common Service – Background Check Integration Community site: https://w3-
connections.ibm.com/communities/service/html/communityview?communityUuid=0e18462a-27ef-48de-
8566-6c7206b7947c

1. Create the subscription to the vendor in Workbench.
2. Select the vendor.
3. Specify the type of integration (select 1-Step or 2-Step, as appropriate).
4. Add authentication information.
5. Reference HR Status to initiate the request
6. Map form fields to background check XML schema.
7. Set up values for packages on the requisition template (Tools > Forms >Reqs >Req forms > Administer

req fields> Background Check Packages). Once the client setting is enabled, two (2) custom static fields
are created automatically.

8. Set up any necessary candidate forms for capturing data

 Associate selected packages to forms (based on req)
 Block HR Status update if form(s) not available

9. Configure a Background Check form to capture the standard results for the background check.

Fields can be hidden for certain user types.
If results are not returned, the form should be inactivated.
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Integrations – Candidate Export Error Notifications

This feature lets clients configure the list of recipients of the Candidate Export Error Notifications.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

RDP 711

 BrassRing

Visible Changes  No – requires specific conditions / configuration for visibility.

How do I get this feature?  Configuration required – contact our Support Team for
implementation details.

Feature Description
Whenever there is an error in the Candidate Export integration, an error notification is sent to BrassRing users.
With this feature, clients can select the user types that receive the error notification emails when the candidate
export integration has errors or fails.

BrassRing User Experience

BrassRing users, of the user types that were selected to receive the notification, receive the error notification
with information fields including:

 Req ID
 Candidate name
 Resume Key

How Do Clients Get this Feature?
This feature is controlled by a new subscription setting in Workbench

Please contact our Support Team or your Certified Workbench User for more information.
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Configuration Tasks

This section describes the tasks required to configure this feature. Tasks labeled Workbench Self Service can
be performed by certified Workbench Self Service users or by our support staff.

Subscription Settings – Workbench (Support Staff)
New setting: Error notification additional recipients is added in the Candidate Export integrations
Subscription administration section.

Path: Tools > Integrations > Administration > Candidate Export > Subscription Admin > Add/Edit
Subscription

Select the user types that you want to receive the error notification emails.
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Click Submit after selecting the desired user types from those available.
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Panels – Candidates in Subpanel Indicator

Previoustly, when using custom candidate results sub panels, which allow configuration of more than one HR
Status to be included in the results, users had no indication of the number (if any) of candidates in the resulting
screen. The user can click the icon only to find that there are no candidates to view. With this feature, the icon
that currently displays for the Custom Candidate Results panel is changed to a linked 0 when no candidates
exist that meet the panel criteria.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

LDP 174

 BrassRing

Visible Changes  Yes – details in Visible Changes document.

How do I get this feature?  Automatic – see details below.

Feature Description
When clients utilize the Custom candidate results sub panels that allow configuration of more than one HR
Status to be included in the results. Previously for clients using such panels, there was no indication of number
of candidates in the resulting screen. Users could click the icon only to find that there were no candidates to
view. With this feature, the icon that currently displays for the Custom Candidate Results panel is changed to a
linked 0 when no candidates exist that meet the panel criteria.

 No changes to the icon shown for the subpanel if one or more candidates exist for the req folder that meet
the subpanel configuration.

 If no candidates exist at the time the panel is loaded or refreshed, then a number 0 displays. The 0 is a link
to the subpanel. The subpanel is unaffected, and will continue to display the no results message when
clicked, as per current functionality. Users can still take actions from the subpanel, such as "View More
Candidates."

 Updates to HR Status that change the count of the candidates in the subpanel from 0 to one or more, or
from one or more to 0, via any method, will update the icon when the panel is refreshed or reloaded. This
does not happen automatically through interpanel events.

How Do Clients Get this Feature?
This feature is available automatically without configuration.
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Panels – Enhancement and new My Tasks

A new IBM® Kenexa® BrassRing® on Cloud panel, My Tasks, is now available. The panel provides recruiters
and hiring managers with reminders to help them take the actions necessary to move candidates forward in the
hiring process. A new Days in Status column is also available on the panel, and for Candidate Results panel
and custom subpanels.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

LDP 139

 BrassRing Workbench Self-Service

Visible Changes  No – requires specific conditions / configuration for visibility.

How do I get this feature?  Configuration required – contact our Support Team for
implementation details.

Feature Description
A new My Tasks panel provides BrassRing users with reminders to help them take the actions necessary to
move candidates forward in the hiring process. A new Days in Status column is also available on the panel, as
well as for Candidate Results panels and custom subpanels. Details are in the follwong sections.

Days in Status

The Days in Status column displays the number of days that the candidate has been in the current HR status,
for the folder from which the panel is viewed.

It is available as an output option for:

 My Tasks panel
 Candidate Results panel
 Custom subpanels – Custom Candidate Results.

The column is sortable, requires no privileges for viewing, and can be added to the panel configuration and/or
added by BrassRing users through Display > Edit Columns.

If an “undo” HR Status is performed and then the status is updated again (after the undo), the count starts over
for the most recent update.
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Visual Indicators for Days in Status

When HR Status aging ranges are configured by status (in Workbench), visual indicators enhance the Days in
Status display by showing whether the time the candidate has remained in that status is acceptable, cautionary,
or unacceptable.

The visual indicator images are not configurable, and appear as a green, yellow, or red line above the number,
where:

 Green = Acceptable
 Yellow = Cautionary
 Red = Unacceptable

My Tasks Panel

A new BrassRring panel, My Tasks, can serve to remind recruiters and hiring managers of pending tasks in the
hiring process, and provides a convenient means to take the next step. The My Tasks panel shows:

 Candidates who have remained in certain HR Statuses for a configured period of time. The candidates are
those associated to reqs for which the user has a my-req relationship, or filed to user’s My folder or My
inbox.

 Candidates who have a form pending approval by the logged-in user.

Your organization determines the triggers that cause candidates to appear in the panel by user type:

 HR Status aging ranges, set by HR Status
 Candidate Forms pending approval

If a candidate qualifies for more than one trigger criteria, the candidate will appear once for each.
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If the candidate is filed into more than one req, and each req qualifies for a triggering criteria, the candidate will
appear appear once for each req, with the Req ID appearing in the Folder column.

Next Step Column

The Next Step column shows the user’s next action, based on why the candidate is included in the panel:

 Update Status action, triggered by HR Status aging
Select the next status from those defined by the client’s tracking logic display (this behaves the same as for
Update HR status from the Candidate Results panel). The HR Status update occurs for the Req (folder) in
which the candidate resides, based on the trigger.

 Approve Form link, triggered by candidate forms awaiting approval
When a Candidate form approval trigger is configured, if the user is the next approver for the form, the
candidate displays regardless of whether the user has a My-req relationship to the candidate. Click the
Approve Form link to open the usual form approval screen.
(For parallel approval processes, the Approve Form link appears as the next step for all the form’s
BrassRing approvers, rather than for the next approver only.)

Once you take the “next step “ and the candidate no longer meets the trigger criteria, the candidate is removed
from the panel.

The Next Step column is unique to the My Tasks panel; it is also required, so cannot be removed using the
Display > Edit Columns menu item.

How Do Clients Get this Feature?
This feature is controlled by Workbench panel configuration for the new panel and Days in Status field. Please
contact our Support Team or your Certified Workbench User for more information.
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Configuration Tasks

This section describes the tasks required to configure this feature. Tasks labeled Workbench Self Service can
be performed by certified Workbench Self Service users or by our support staff.
To enable these features:

 Configure Days in Status
 Set up HR Status Aging indicators and triggers
 Configure My Tasks panel
 Map panel configuration to user types

Days in Status Configuration – Workbench Self-Service (Tiers 4+)
The new Days in Status panel standard field is available in the Search for field screen for panel configuration
of these panel types:

 Candidate Results
 Custom Subpanels (Candidate Results)
 My Tasks

Tools > Settings > Panel Configuration > Administer configuration [for Candidate Results, Custom
Subpanel, or My Tasks selected panel type] > Add new configuration/Save configuration as new [for
selected name]/Edit [for selected name] > Add row (if desired) > Select field

Days in Status column label is customizable in Panel configuration. Click View/Edit translations [for Days in
Status row] on the panel configuration screen, then enter the desired label and/or translations.
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If adding to an existing panel configuration, apply the Override User Customization option in order for the field
to display automatically for the user. BrassRing users can also can add the field through the Edit columns
menu.

The Days in Status visual indicators are configured in Tools > HR statuses (see the following HR Status Aging
section).

HR Status Aging – Workbench Self-Service (Tiers 5+)
Set HR status aging parameters in a new section called HR Status Aging. You can:

 Define the range for number of days it is acceptable, cautionary, or unacceptable for a candidate to remain
in the status. This also sets the visual indicator to display in the Days in Status column (with no ranges
defined, only the number of days displays).

 Set the option to use the range as a trigger for the display of candidates on the My Tasks panel. Once set,
an HR Status Aging trigger for the status becomes available for configuration of My Tasks panels (see
Panel attibutes section of My Tasks panel configuration).

HR Status Aging section is available from the the Actions tab of the Add or Edit HR status screen. This section
is available only for non-final statuses, that is, Start and Intermediate statuses only.

Tools > HR statuses > Add/Edit [selected non-final] status > Actions tab > HR Status Aging section
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1. To set a visual indicator, enter the number of days-in-status range for any or all of the three visual
indicators, as desired. Indicators are displayed in the Days in Status column as a green bar for acceptable,
yellow bar for cautionary, or red bar for unacceptable above the actual number of days in the status. (From
value must always be less than To value. Ranges cannot overlap, Acceptable range should be less than
Cautionary range should be less than Unacceptable range). The visual indicators apply to the Days in
Status column for any panel on which it can be displayed.

2. To make a status and specific aging range available for selection as a My Tasks trigger (configurable for My
Tasks panels), check the range’s Trigger for My Tasks Panel checkbox. Only one row needs to be
checked in order for the status to appear in the panel attributes search screen as an trigger option; if the
status is selected as a trigger, candidates in that specific range will appear on My Tasks. Check more than
one row to display candidates in those additional selected ranges in the panel.

3. Click Save.

My Tasks Panel Configuration – Workbench Self-Service (Tiers 4+)
There is one standard configuration for My Tasks, named Basic View.
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The Add new configuration action defaults to the selections for Basic View, which includes the required Next
Step column as well as Days in Status column.

You can add a new configuration in:

Tools > Settings > Panel Configuration > Administer configuration [for My Tasks panel type] > Add new
configuration/Save configuration as new [for selected name]/Edit [for selected name]

In addition to the required Next Step field, the same fields available for a Candidate Results panel are available
for selection on a My Tasks panel. Use Add row as needed. Click Select field to select or change a field.
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My Tasks Panel Attributes

To view or change attributes, click Edit beside the Panel attributes label.

Tools > Settings > Panel Configuration > Administer configuration [for My Tasks] > Save configuration
as new [for Basic View] > Edit [Panel attributes]

Default Sort Options

Choices are the same as for Candidate Results.

Available Filter Fields

Two options, Candidate Type and HR Status, are selected by default for all existing and new configurations.
Filter menu does not display if neither field is selected.

Triggers

Triggers are the configured criteria that determine which candidates should display in a My Tasks panel.
Triggers are set by panel configuration, and since a configuration is associated with specific user types through
panel mapping, you effectively can set different triggers for different user types.

The new section for configuring triggers displays in the Panel attributes screen only for the My Tasks panel. At
least one trigger must be selected from the trigger types available:

 HR Status aging ranges, set by HR Status (when a candidate has been in the status for a number of days
within a configured range that’s also been specified as a My Tasks panel trigger)

 Pending my approval: Candidate form (when a candidate form awaits the user’s approval)

To select the triggers for the My Tasks panel:
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1. Click List>>. On the Search for screen, the Available pane includes all HR Statuses for which a Trigger for
My Tasks Panel checkbox is checked for any or all of its specified ranges (acceptable/ cautionary/
unacceptable).

 Pending my approval: Candidate form is a standard trigger that is the default:
 Other triggers include all HR Statuses for which one or more Trigger for My Tasks Panel checkboxes

are checked.

2. Select desired triggers.
3. Click Submit.
4. Save the panel configuration.

If a candidate qualifies for more than one trigger criteria, the candidate will appear once for each trigger. If the
candidate is filed into more than one req, and each req qualifies for a trigger criteria, the candidate will appear
appear once for each req.

The Req ID will only show in the Folder column if the trigger criteria is met in conjunction with a specific req.

User Type Panel Mapping – Workbench Self-Service (Tiers 4+)
The panel mapping dependencies and user type privileges for the new My Tasks panel are the same as for the
Candidate Results panel (Workbench > Tools > Users > User types > User type panel mapping [for
selected user type]).
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To make the panel appear for the user type, select My Tasks and then a panel configuration from the drop-
down.

When changing an existing panel mapping, apply the Override User Customization option in order for the
panel to display automatically for the user type (in case someone has modified the display).
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IBM Kenexa Recruit and Onboard App – Candidate Export
by Update HR Status

This IBM
®

Kenexa
®

Recruit and Onboard App feature introduces asynchronous candidate exports based on HR
Status updates.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

RDP 760

 BrassRing

 Recruit and Onboard App

Workbench Self-Service

Visible Changes  Yes – details in Visible Changes document.

How do I get this feature?  Automatic – see details below.

Feature Description
Clients using IBM Kenexa Recruit and Onboard App via mobile devices can now perform asynchronous
candidate exports based on a candidate's HR status update, for requisitions configured to allow for candidate
export. BrassRing users with the requisite Candidate user privileges can access this feature on a mobile device
and receive alerts when exports are queued. Additionally, when candidate exports complete, BrassRing users
can view candidate exports on the BrassRing Admin > Admin+ > Candidate Export page.

BrassRing User Experience

BrassRing users with the appropriate user privileges can access this functionality on a mobile device.
BrassRing user:

1. Taps a req folder and views all candidates within that req folder.
2. Taps to select a candidate.

3. Taps the Actions drop-down menu to select an HR Status for the selected candidate.
4. Taps Update Status.

Mobile screen refreshes and notifies BrassRing user that the HR Status Update has been submitted for
processing and displays the export transaction ID number.
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Limitations and Known Issues

The feature has the following known limitations:

 Synchronous candidate export is not supported.

 Candidate export/Update HR status is only supported for one candidate at a time.

How Do Clients Get this Feature?
This feature is available automatically without configuration. Requisitions used in this workflow must be
configured to allow for candidate export and BrassRing users must have the following user privileges to access
this functionality:

 Candidate Actions 2 - Candidates – HR Status - add/update in all reqs/all folders/my inbox.
 Candidate Actions 2 - Candidates – HR Status - add/update in my reqs/all folders/my inbox.

Please contact our Support Team for more information about enabling these privileges.
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Configuration Tasks

User Type Privileges – Workbench Self-Service (Tiers 1+)
BrassRing users must have the following User Type Privileges to access this feature's functionality.

Existing user type privileges:

 Candidate Actions 2 - HR Status - add/update in all reqs/all folders/my inbox.
 Candidate Actions 3 - HR Status - add/update in my reqs/all folders/my inbox.

1. Workbench > Tools > Users > User types > Edit type permissions.
2. Select Candidate Actions 2 edit icon.
3. Select HR Status - add/update in all reqs/all folders/my inbox.
4. Select HR Status - add/update in my reqs/all folders/my inbox.
5. Click Done.
6. Click Save.
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IBM Kenexa Recruit and Onboard App – Selecting and
Copying Forms

This IBM
®

Kenexa
®

Recruit and Onboard App feature allows clients to select per-req candidate forms when
moving or copying candidates from one req folder to another.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

RDP 759

 BrassRing

 Recruit and Onboard App

Workbench Self-Service

Visible Changes  Yes – details in Visible Changes document.

How do I get this feature?  Automatic – see details below.

Feature Description
Clients using IBM Kenexa Recruit and Onboard App via their mobile device can now move and copy per-req
candidate forms when moving or copying candidates from one req folder to another. Previously, when Recruit
and Onboard App users moved/copied candidates from one req folder to another, candidate req forms did not
move with the candidates.

BrassRing User Experience

Recruit and Onboard App users with the appropriate user privileges can access this functionality on a mobile
device. On a mobile device, user:

1. Taps a req folder and views all candidates within that req folder.
2. Taps to select a candidate.
3. Taps Move/Copy to Req/Folder in the Action section of the screen.

Move/Copy candidate to Req/folder optimized screen launches.
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4. Taps Move or Copy.
5. Taps List to select a Destination folder or a Work folder.
6. Taps to select an HR Status Option.
7. Taps to select applicable forms in the Forms to copy to destination req(s) selection box.

Single per candidate per req form and multi per candidate per req are copied into the destination req.

If no per-req forms exist for the candidate in the source req, the Form to copy to
destination control does not display.

8. Taps Move/Copy button.

Limitations and Known Issues

The following limitations are noted:

 If a candidate already exists in the destination req folder, no form activity occurs.

 When moving or copying to a requisition folder, auto-fill fields pulling from a req field are replaced with the
destination req field values.

How Do Clients Get this Feature?
This feature is available automatically without configuration. Recruit and Onboard App users must have the
following user privileges to access this functionality:

 Candidate Actions 2 - Candidates - move/copy to All Reqs (or Candidates – move/copy to My reqs)
 Candidate Actions 3 - Candidates - copy per req forms

Please contact our Support Team for more information about enabling this feature.
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Configuration Tasks

User Type Privileges – Workbench Self-Service (Tiers 1+)
BrassRing users must have the following User Type Privileges to access this feature's functionality.

Existing user type privileges:

 Candidate Actions 2 - Candidates - move/copy to All Reqs (or Candidates – move/copy to My reqs)
 Candidate Actions 3 - Candidates - copy per req forms

1. Workbench > Tools > Users > User types > Edit type permissions.
2. [for selected type] > Candidate Actions 2.
3. Select Candidate Actions 2 edit icon.
4. Select Candidates - move/copy to All Reqs.
5. Click Done.
6. Select Candidate Actions 2 edit icon.
7. Select Candidates – copy per req forms.
8. Click Done.
9. Click Save.
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Reqs – Autocomplete Field Enhancements

Ease-of-use and performance enhancements have been made for autocomplete fields when users are adding,
editing, and approving enhanced-layout requisitions in IBM® Kenexa® BrassRing® on Cloud.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

RDP 768

 BrassRing

Visible Changes  Yes – details in Visible Changes document.

How do I get this feature?  Automatic – see details below.

Feature Description
Ease-of-use enhancements have been made for autocomplete fields when BrassRing users are adding, editing,
and approving enhanced-layout requisitions. Autocomplete fields are those multi- and single-select field types
that have more than 200 options (which replaced the List>> button in the classic layout). Enhancements
include:

 New List and Spinning icons for the autocomplete list boxes improve user experience.
 Number of autocomplete results displayed in the list boxes is increased from 10 to 100.

Icons

1. List icon is a blue arrowhead displayed when no text is entered in the autocomplete box.

When users click this icon, a list of the first 100 available results is displayed. The icon disappears when
users start entering text in the search box.

2. Spinning icon has two blue arrows rotating in a circle, displayed while the system is looking up matches for
text as the user enters it.

When the list of matches is displayed, the spinning icon disappears.

Number of Results

The number of results shown in the autocomplete box has increased from 10 to 100. If more than 100 matches
exist,users see Displaying the first 100 results at the bottom of the list.

How Do Clients Get this Feature?
This feature is available automatically without configuration for requisitions using enhanced layout req forms.
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Reqs – Offers Remaining Field

IBM® Kenexa® BrassRing® on Cloud has a new custom Req field, Offers Remaining, that can count down the
req’s remaining openings based on intermediate HR Statuses. This may help clients avoid over-hiring, by
providing a postions countdown that can be triggered earlier in their process, by a pre-final HR Status.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

RDP

 BrassRing

 Data Insight Tool

Workbench Self-Service

Visible Changes  No – requires specific conditions / configuration for visibility.

How do I get this feature?  Configuration required – contact our Support Team for
implementation details.

Feature Description
A new BrassRing custom Req field, Offers Remaining, can count down the req’s remaining openings based on
intermediate HR Statuses (that have a new Count down ‘Offers Remaining’ status attribute). This may help
clients avoid over-hiring, by providing a postions countdown that can be triggered earlier in their process, by pre-
final intermediate HR Statuses ( unlike the Positions Remaining field that decrements only for a final HR Status).

The new field can be placed on any Req form, with the label name customized per form, as needed. BrassRing
users can view Offers Remaining on the Req Details page as well as from the Open Reqs panels.

The field applies for reqs with status of Open, On Hold, Closed, Canceled and Deleted. It is initially populated
when the req is opened (manually or through Req Import), and subsequently updated when a candidate HR
Status is updated or the Req is edited.

 If a candidate has a current status that has the “‘count down..”’ attribute, and that status is undone, the value
is recalculated based on the new current status.

 The value is not editable by any user.

HR Status updates that trigger recalculation include:

 Candidate Results Panel: HR Status update via Actions menu and HR Status editor
 Reqs > My or All Reqs > Open: HR Status update via the Actions menu or HR Status link in the grid
 RAM HR status updates
 HR Status updates via integration
 Move/copy to req action, retaining HR Statuses (either manually or via RAM)
 File to req with HR Status
 Talent Gateway HR Status updates via candidate submission/reapply or withdrawal/reactivation

If reqs are already in an open status when the new field is added to the template, the
initial value for the “Offers Remaining” field is not entered until triggered by one of the
preceding actions. Therefore, an open req will have no value for the field in the interim.

BrassRing User Experience

When editing or viewing reqs on the Req Details page or from the All/My Open Reqs panels, users see a non-
editable value showing the potential number of offers remaining. The value is based on the following calculation:

[# of positions remaining] - (minus) [number of candidates who have the current HR Status(es) with “count
down offers remaining” attribute selected in this req folder]
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If a req has never been in the Open status, as can occur with On Hold or Deleted reqs, the field will display no
value (since it was never populated).

When adding a new req, the field is blank until the req is opened.

The new field can also be added to the All Open Reqs or My Open Reqs panels (via Workbench Panel
configuration or by users through the Display > Edit Columns menu).
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A negative number can appear for Offers Remaining. This indicates potential overfilling
of the req.

In the panel column, if the field has not been added to a template, it displays as blank.

The “Offers Remaining” count is not automatically refreshed when it is displayed in a panel due to
technical/performance reasons. Instead, this value is dynamically calculated on page load. The value is not
refreshed when candidate’s HR status is updated (or WB setting is changed) unless or until the page displaying
it is refreshed. This is consistent with the “Positions Remaining” count behavior.

RAM and Data Insight Tool

When enabled, the new Offers Remaining field will display in Rules Automation Manager and Data Insight Tool
as an additional custom Req field, per current functionality. In RAM, it will appear in the conditions (all conditions
where Req fields are listed), and will allow the user to set a rule to include the value of this field to Equal or Not
equal any positive or negative number.

How Do Clients Get this Feature?
This feature is controlled by a new client setting and HR Status attribute. Please contact our Support Team for
more information about enabling this feature.
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Configuration Tasks

This section describes the tasks required to configure this feature. Tasks labeled Workbench Self Service can
be performed by certified Workbench Self Service users or by our support staff.

To configure this feature, you:

 Set new client setting
 Set HR Status attribute
 Add Offers Remaining field to Req forms
 Add field to panel configurations (optional)

Client Settings – Workbench (Support Staff)
New client setting: Req offers remaining field

Before turning on this setting, check to make sure the client does not already have a
req field named OffersRemaining (check in Tools > Forms > Reqs > Req forms >
Define custom req fields). This name would conflict with the name of the one
automatically created when you enable this client setting. If there is an existing field
with the DB Name = OffersRemaining, the new field will not be created automatically. If
a filed name conflict exists, enter a ticket requesting Engineering to change the DB
Name for the existing custom field prior to turning on the client setting.

Workbench > Select a client > Edit
–OR–
Workbench > Admin > Manage Clients > Edit client settings [for selected client]

Allows setup of Offers Remaining count functionality

Yes - automatically triggers the following

 Creates new custom req field, Offers Remaining
 Adds new HR Status Actions setting to existing and new intermediate HR Statuses

No – This is the default, no Offers Remaining count.

Once set to "Yes" and the Offers Remaining field is added to at least 1 Req template, or the new HR Status
actions attribute is set for at least one HR Status, or the field has been added to at least one Req Panel
configuration, the "No" setting should become disabled

HR Status Action – Workbench Self-Service (Tiers 7+)
Designate desired intermediate HR Statuses as a countdown status for the OffersRemaining field in:
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Tools > HR statuses > Add/Edit [selected intermediate] status > Actions tab

Select Count down ‘Offers Remaining’ checkbox and Save.

Once checked, the status will be included in the “Offers Remaining” calculation.

The Offers Remaining calculation is performed onlfy for intermediate status types,
since the hiring statuses it’s intended to count down should not be a start statues, and
final statuses are already considered for existing position countdown functionality.

Req Form Fields – Workbench Self-Service (Tiers 1+)
Once the client setting is enabled, a new custom Req field is added to the Req field index shown in:

Tools > Forms > Reqs > Req forms > Define custom req fields

You can optionally edit the field, although certain field attributes are not editable, including: Type, Min, Max,
Search/output, Field associations. You can modify other attributes such as placement, field name and font.
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To edit (if desired), click Edit field attributes.

Add Field to Req Forms

In order for the new calculation to show for a Req, select and add the new field to the desired Req forms.

Tools > Forms > Reqs > Req forms > Administer req fields [for selected form] > Select req fields
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1. Select the field and click Add.
2. Position as desired and Save.

On individual req forms, additional restrictions are placed on editing of the field’s attributes.

Tools > Forms > Reqs > Req forms > Administer req fields [for selected form] > Edit field attributes icon
[for OffersRemaining field

The Non-editable for these user types field attribute automatically has all user types selected, with Extend to
add req also selected. OffersRemaining field cannot be modified, nor will it be required for any user types.

Other field level attributes that are not editable include: Question Branching, Min, and Max values.

You can modify other attributes such as Field name, Hide for these user types and Hide in these languages.

Open Reqs Panel Configuration – Workbench Self-Service (Tiers 4+)
You can add the new OffersRemaining custom req field to panel configuration of these panel types:

 All Open Reqs
 My Open Reqs
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Tools > Settings > Panel Configuration > Administer configuration [for selected Open Reqs panel type] >
Add new configuration/Save configuration as new [for selected name]/Edit [for selected name] > Add row
(if desired) > Select field

1. Select Req fields (custom) OffersRemaining from the Available pane in the Search for field screen.
2. If adding to an existing panel configuration, apply the Override User Customization option in order for the

field to display automatically for the user. BrassRing users can also can add the field through the Edit
columns menu.

(The OffersRemaining field appears in the Available list for Reqs Pending Approval panels as well. However,
since it is not applicable to pending reqs, the field will be blank if configured.)
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Reqs – Redesigned Posting Pages

A re-designed Posting (Options) page and new Site Options page and in IBM
®

Kenexa
®

BrassRing
®

on Cloud
allows users to more quickly and efficiently post to BrassRing Talent Gateways, especially when the same
questions are required for multiple gateways and languages.

IBM
®

Kenexa
®

BrassRing
®

on Cloud Release 13.4

Feature Areas

LDP 150

 BrassRing  Talent Gateways

 BrassRing Agency

Visible Changes  No – requires specific conditions / configuration for visibility.

How do I get this
feature?

 Configuration required – contact our Support Team for implementation
details.

Feature Description
A re-designed Posting (Options) page and new BrassRing Site Options page and allows users to more quickly
and efficiently post to BrassRing Talent Gateways, especially when the same questions are required for multiple
gateways and languages.

 Key updates to the Posting Options Talent Gateway grid and BrassRing Agency Gateway grid conserve
space and add ease of use.

 Site Options page replaces the former “Site Questions” page, and features an all-on-one page design.
 These features are controlled by a client setting, so clients can choose when to turn it on.

Posting Options BrassRing Talent Gateway Grids

Updates to the Talent Gateway grid on the Posting options page include:

 Columns reduced and reorganized to minimize horizontal scrolling:

 “Select all” column header replaced by a checkbox
 BrassRIng Gateway Questionnaire View Details column removed and added to appear under the GQ

selection menu in the Select Gateway Questionnaire column
 Currently Posted column now a visual indication (bolded Gateway name if req is currently posted to it)

rather than a separate column
 Site Questions push pin and “Repost” button (if configured) relocated to Actions menu.

 “Actions” menu for each Gateway – location closer to the context of the Gateway. Actions include:

 Edit Site Options
 Repost (reposts the job to selected gateway, updates Posted Date to the current date, and applies any

changes to Days until posted, Days to remain posted, Time, Zone, Gateway Questionnaire, Assessment
Batch, or Site Options page will be applied)

 Featured Job visual indication and control brought up to this level
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Featured Job Selection at Posting Options Level

You can now select Featured Job at the Posting Options level. When the Featured Job item is selected, a check
mark displays in the menu and a star displays next to the gateway name. To deselect, select the item again.

 If 10 jobs have already been designated as featured for the Gateway (actively posted/selected for the
Gateway with a current or future posting date), then the option is disabled, with hover text of: “10 Featured
Jobs have already been designated for this Gateway.”

 The visual indication (star preceding gateway name) displays as soon as it is selected in the menu.
However, if the gateway itself is not selected as well, the setting is not saved. This is consistent with other
settings in the grid that appear to take effect without selecting, but actually do not.

 Per existing functionality, the Featured Job designation is not honored through Job Code Default Data, even
if configured. The only way to designate a featured job is through this menu item.

Featured Job Selection – Closing the Loophole

Since the Featured Job designation is now done on the Posting Options page, there are some inherent
changes:

 For Global Gateways, featured job can no longer be designated at the language level.
 A job can no longer be selected as “featured” but not selected for posting.

This allows the user to clearly see that a job is featured from the posting page, as well as designate it as
featured without going to the Site Options page.
It also closes the loophole whereby a user could designate a job as featured and not post it, then return to
post it later and the number of spaces available was not enforced.

Days to remain posted Input

The Days to remain posted field has changed from a select list to numeric text entry.

Keep the following items in mind:

 For the posting dependencies configuration of "Minimum posting duration settings"
(and user type privilege and Req template is selected), the field will not accept a value
that is lower than that set for the template. If value is exceeded and entered, then it will
reset to the last value seen when the user moves away.

 Changes have been made to how Evergreen Reqs display (see Evergreen Reqs and
Days Posted)

New Calendar Control

When you click or tab into the date fields, the date populates based on the Days column, and a calendar control
opens.
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 Days in the past are disabled, and the control never
shows months in the past.

 If the date that is displayed is in the past, it updates to
current date when selected.

 Removal date only: For the posting dependencies
configuration of "Minimum posting duration settings,“ an
entered date that violates the rules reverts to the
previous value, and the days in the calendar are
disabled.

 The field also accepts typed input, but accepts only a
valid current or future date. If you enter a date more
than 365 days from the current date, no value, or an
unrecognized date, the value defaults to the previous
value (reflected in the Days until posted) when clicking
Enter or Tab, or click away.
Acceptable date formats must follow the day-month-
year order, but can include numbers or 3 letter
abbreviations for month, leading 0’s, four- or two-digit
years, delimiters of period (.), forward slash (/), hyphen
(-), comma (,) comma space (, ), or space ( ). Delimiters
cannot be mixed within one entry.

Examples of acceptable formats

4-Sep-13, 04-Sep-13, 4/Sep/13,04/Sep/13, 04
Sep 13, 04-Sep-2013

Examples of unacceptable formats:

9/04/13, 9/4/2013

Evergreen Reqs and Days Posted

For Evergreen Reqs – Days to remain posted and Removal date, the “infinity” symbol ( ) now displays in
place of the double hyphen (- -)

 For Evergreen reqs, clicking in or tabbing to Days until posted, Days to remain posted, Posting date, or
Removal date fields selects (highlights) value text.

 Clicking in or tabbing to Posting date or Removal date fields does not launch the calendar immediately.
Once focus is in those fields showing an infinity symbol, press any key (that is, set the value to anything
other than the infinity symbol) to display the calendar.

 The Calendar defaults to 365 days after the posted date selected, and the date is updated.
 To revert to the infinity symbol, delete the date.

Posting Options BrassRing Agency Gateway Grids

Updates to the Agency Gateway grid on the Posting options page include:

 Columns reduced and reorganized to minimize horizontal scrolling (“Select all” column header replaced by
checkbox, Select/edit agency access, Edit site questions (formerly appeared as Site Questions push pin)
and Repost button (if configured) relocated to Actions menu).

 “Actions” menu for each Site – location closer to the context of the BrassRing Agency gateway name
 Same changes as Talent Gateway to Days posted and Posted/removal dates calendar controls
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Site Options Page

To access the new Site Options page, click the Edit Site Questions action in the pull-down control for the
desired gateway.

Site Options page combines question search, selection, scoring, filtering, and other settings into one page.

On the left:

 All available questions are listed.
 Real-time search and filter tools help you find what

On the right:

 Detail View tab shows each selected
question, its options, and scoring.
For help text on standard fields, click the
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you’re looking for quickly.

Select (or remove selected) by any of these methods:

 Ctrl or Shift + Click to select multiple
 Drag and drop from Available to Selected and back,

as well as within selected
 Double-click (adds to the end of the list)
 Select and use arrow buttons (beside Available

Questions heading).Selected questions are added to
the end of the list.

information icon beside it. (Help is not
customizable.)
Hover text for the question type indicates if
it’s a Talent Gateway default question.

 List View tab shows simplified view for
working on question order or selection
(when scoring isn’t needed)

To scroll the Selected Questions, use the scroll
arrows at upper right.

Available Questions Search and Filter

To search:

Start typing in the search box;
matches appear below as you
type.

To clear your typing, click the red

x.

To filter:

Click the filter icon.

 Filter uses current
“Jump to” links for
label fields on the
Talent Gateway form

 Can filter on more
than one section at a
time

 Can use filter and
search together

 Filter icon “glows”
when one or more
filters are in place
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Selected Questions Detail View Tab

The question Detail View is the default tab, displaying the selected questions, their options, and scoring.

 Scroll through the selected questions using the right and left arrow carousel control at upper right.
 To reorder questions from this view, drag and drop by “grabbing” the highlighted field type (e.g., Radio

Button, Text Box) section and dropping where desired within the carousel. Depending on the number of
questions in view, it may be difficult to drop it in the desired place. If so, reordering within the List View is
recommended.

 Questions designated as Default for the Talent Gateway have an asterisk beside their question type (radio
button, checkbox, single select, and so on).

 Entire text of each question displays.
 Required for HR Status Update score signifies the individual question threshold required for an HR Status

update (when client setting Talent Gateway Score - Update HR Status is enabled).

When Question Branching is set up on a Talent Gateway form, the gateway honors the
branching, but the posting/site questions pages do not access or reflect branching
information. Therefore, when related parent or child questions are not selected, these
are the existing rules that the gateway follows:

 If a parent is selected but not the child, the field will not show the child on the TG.
 If a child is selected but not the parent, the child will not display on the TG.

Detail View Scoring and Other Settings

Detail View provides everal ease-of use features related to scoring:

 As you enter scores, Highest Possible Score is updated with a flash of yellow. This score is the sum of the
maximum scores given to the individual questions.

 Preferred Candidate and HR Status Update sections are the same, but with added help text.
 Notify system users will display as an “autocomplete” box for 200+ users.
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Assessment Minimum

Change in behavior from the classic page:

 Assessment Minimum field (total score
required to administer assessments) displays
only if the client setting
IntegrationAssessment is set and the
BrassRing Talent Gateway setting of
Always launch assessment(s) is not
selected

 On the classic page, the field always displays
if the client setting is set, but if Always
launch assessment(s) was selected, the
value was ignored.

Selected Questions List View Tab

The List View offers a simplified view for when you are working on question order or selection (when scoring
isn’t needed).
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Change question order using drag & drop or click into
the number input and change to desired position.

JSQ Question group selection (if
configured) is located on this tab.

Question Group designates the group that the question should belong to when displayed on the Talent Gateway
to the candidate.

Languages and All Languages Mode

The language toggle displays bove the Available Questions list for Global Talent Gateways so you can display
the questions that have a translation for the selected language. It displays when the Req has been translated
into one or more of the Global Member Gateway languages.

You can also set All languages mode by selecting On. This mode provides a convenient and powerful way to
apply settings from the current language’s question set to their counterparts in “all” languages for the gateway.

When set to Off, each language of a Global Talent Gateway can have different questions and settings.
Switching to On limits the available questions to those common to all languages only, and applies the current
language’s selected questions, Scoring, Baseline, and Preferred Candidate values to the other languages. In
some cases, currently selected questions may be removed if translations do not exist for all of the languages.

All mode can be switched on and off at any time. However, note that turning the mode off after turning it on does
not undo the actions of merging the language settings. If some questions are common to all languages, but
some differences are needed as well, use All mode to set those common settings, then switch it off to apply the
differences.

Specifically, when All mode set to On:
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 Warning message displays. Click Continue to go to the next step (or click Cancel to leave the setting off
and close the message).

 Page refreshes to show only Available questions and Filters that are translated into all toggle languages. If
any filter were selected, they are cleared.

 Selected questions refreshes to list only those from the current toggle that are translated into all the toggle
languages.

 On Detail View tab, Scoring, Baseline, Preferred Candidate, and HR Status Update settings are copied
from the current toggle language to all other languages.

 Toggles not visited are saved with the same values as the current toggle.
 Once turned on, the background color of the language mode selection turns blue to cue the user they have

changed modes

For language mode, when you save:

 Mode currently set (On or Off) is saved and next time you open the page, that mode is selected by default.
Off is the default for all unviewed pages.

 Toggle mode state is copied in the “Copy to Other Gateways” feature.
 In On mode, you can still toggle from language to language, but changes in any language toggle propagate

to all the other toggle languages.

To remind yourself at any time about what this mode does, simply click the circled-i information icon beside the
setting.

Copy to Other Gateways

A convenient Copy to Other Gateways action on the new Site Options page allows you to copy the questions
and settings selected to other gateways (button does not display if a BrassRing Gateway Questionnaire with no
JSQ widget is selected).
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You can check specific gateways or click the Select all control checkbox at the top to select all.

Business rules governing what gateways display as “targets” of the copy are:

 If current gateway is single-Language, eligible targets are any other single-Language gatweways of the
same language

 If current gateway is Global – eligible targets are any other Global gateway with the same or fewer
languages, as well as single-Language gatweways of the same language

 Gateways that meet the preceding two rules but have a GQ with no JSQ widget selected at the time of page
load are excluded.

The Copy to Other Gateways action only saves the questions and settings data – it does not post to the target
gateways. A confirmation message displays the gateway names to which site options have been successfully
saved, and warns you that additional action is required to post.

 You must select the gateways to which to post on the main posting options page, if not already posted.
 If already posted, the copy action will update what is currently posted after you update using one of the

usual update actions: Update all postings, Update newly selected/unselected postings only, or
Repost.
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Save Site Options

When you Save the new Site Options page, there is no pop- up confirmation that needs to be clicked; the page
simply closes. You return to the Posting Options page, scrolled to your previous location.

 Gateway row for which the Site Options page was saved flashes with yellow
 A message displays above the Gateway name for 12 seconds, or until you click or scroll

“Site Options have been successfully updated. Changes will not be posted until further action is taken on
this page.”

To post your changes, use one of the usual update actions: Update all postings, Update newly
selected/unselected postings only, or Repost.

Limitations and Known Issues

The new Posting Options page does not display correctly (including the display of the Actions menu) when using
compatibility mode with Internet Explorer 10. Turn off compatibility mode in order for the page to functional
correctly.

How Do Clients Get this Feature?
This feature is controlled by a new client setting. Please contact our Support Team for more information about
enabling this feature.
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Configuration Tasks

This section describes the tasks required to configure this feature. Tasks labeled Workbench Self Service can
be performed by certified Workbench Self Service users or by our support staff.

Client Settings – Workbench (Support Staff)
New client setting: Posting Options Page – New UI

Workbench > Select a client > Edit
–OR–
Workbench > Admin > Manage Clients > Edit client settings [for selected client]

Sets the display of the updated Posting Options and Site Options pages. All BrassRing users who have access
to the Posting Options and Site Questions pages will see the updates. These pages will launch for all Req-
related workflows such as:

 Push-pin icon (panels and classic listing pages)
 Actions Menu (panels, classic and Req Form)
 Req status change workflows including eLink to open
 NOT INCLUDED: Add/edit Job Code Default Data through Admin +

No – Pages without the updates will continue to display per current usage (No is the default).

Setting can be turned off and on as desired, there are no restrictions.

Note: The TG Admin setting for Gold Service Level (service level did not allow job-specific questions, supporting
Talent Gateway default questions only) will no longer be honored when the client setting is turned on. Service
levels are no longer used/sold, and there will be no differences in the new Site Options page based on service
level.

As with any other large feature change, it is important for the client to FULLLY TEST in
their own staging environment before turning this on.

User Type Privileges – Workbench Self-Service (Tiers 1+)
Existing user type privileges that BrassRing user need for the Site Options page are:

Workbench > Tools > Users > User types > Edit type permissions [for selected type] > Talent Gateways

 Questions - edit questions and scoring
 Questions - multiple questions scoring
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Reqs – Setting My Req Relationship via User Profile

This feature provides an automated way to provide a My-Req relationship in situations with high mobility rates or
turnover among hiring managers, where the usual manual maintenance can be difficult. It allows the My-Req
relationship to be defined via a new user profile field.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

LDP 196

 BrassRing Workbench Self-Service

Visible Changes  No – requires specific conditions / configuration for visibility.

How do I get this feature?  Configuration required – contact our Support Team for
implementation details.

Feature Description
This feature allows the My-Req relationship to be defined via a user profile field. You can:

 Update all a user’s My-Req relationships simply by updating their User Profile field
 Easily update requisition privileges related to employee transfers and company reorganizations!

Here’s how it works. When the feature is enabled by client setting, a Req field is selected. In addition, one or
more of its options is selected on the user’s profile. When a requisition’s option value for the selected field
matches an option value selected on the profile, the user has a My-Req relationship with the requisition, with all
the functionality a Req Team member would have. If either the Req value or the user profile option value
changes, the My Req relationship dynamically changes as well.

General Rules

 When there is a match between any of the options selected for the requisition and an option selected on the
user’s Requisition privileges profile field, the user has a MyReq relationship to the requisition. However,
the user is not listed in the Requisition Team field as a result of the relationship.

 Org Groups are respected. If the req field option matches the user’s but the Org Groups with which the user
is associated don’tt have privileges to the req’s req form, the user will not be granted a My-Req relationship.

 When the options selected for the user on their profile are updated through any means (XML user import,
Excel user import, manually via Workbench or BrassRing) then the My-Req relationship is automatically
updated, essentially real-time. This includes both establishing new My-Req relationships as well as severing
those that are no longer valid.

 When the Req option is updated or created through any means (Add/Edit Req, Req import, RAM-update
custom field, Req Mass Update), the My-Req relationship is automatically updated, essentially real-time.
This includes both establishing new My- Req relationships as well as severing those that are no longer valid.

 All My-Req privileges for the user’s user type are respected. For example, whether the user can Edit or View
the req is determined based on the My-Req privileges. If the user does not have the applicable My-Req –
view, they will not see the requisitions even though the user profile criteria matches the req criteria.

 User Profile imports support “Replace All” action only.
 The Requisition Team field is respected if the user appears in the Req Team field. Thus, even if the user

profile field doesn’t match the req field, the user still has a My-Req relationship to the req.

How Do Clients Get this Feature?
This feature is controlled by a new client setting, Req privilege based on User Profile option. Please contact
our Support Team for more information about enabling this feature.
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Configuration Tasks

This feature is controlled by:

 New client setting that provides a way to map a req field to a user profile field. Where there is a match, the
user will have a My req relationship.

 Assignment of field options for the Req field selected in the client setting, which grants the user the My Req
relationship when the option value matches. This can be done by editing the user's profile from either:
Workbench (Tools > Users > Administer BrassRing Users)
BrassRing (Admin> Admin+ > Users).
Edits or updates take effect for the user regardless of which interface (BrassRing or Workbench) you use.

 Ensure that the Req field is added to desired Req forms.

Tasks labeled Workbench Self Service can be performed by certified Workbench Self Service users in indicated
tiers or by our support staff.

Client Settings – Workbench (Support Staff)
New client setting: Req privilege based on User Profile option

Workbench > Select a client > Edit
–OR–
Workbench > Admin > Manage Clients > Edit client settings [for selected client]

This setting provides a means to create a My Req relationship for users without including them in the Recruiter,
Hiring Manager, or Requisition Team fields. The user is granted a My Req relationship when you assign field
options on the user's profile from the field selected here.
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1. Click Configure. The Search for field – Requisition fields screen opens.

2. Select the field that is to drive the relationship between requisition and user from the master-level standard
and custom option- based req fields (of type Single Select, Multi Select, Checkbox or Radio Button).

3. Click Save.

Once the client setting is saved, a new multi-select Requisition privilege field displays on the Edit user screen
in Workbench and in BrassRing Admin. Choose options from the selected field to be mapped to the user’s
profile. When those options are selected on a Req, the user will have a My-Req relationship with it.

Notes: Once a field is selected for the client setting: field type cannot be changed; field cannot be inactivated;
field’s options can be inactivated.
To turn the client setting off, Click Configure and use Remove button to remove the selected field.

Edit User– Workbench Self-Service (Tier 7 Power User)
After the req field is selected in the client setting, in the user profile you can set the options that will create the
My-Req relationship when those options are selected on a Req. This can also be done in BrassRing Admin.

Workbench > Tools > Users > Administer BrassRing Users

1. Click Edit icon for the selected user.
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2. Click List>> and select desired options from the Req field selected in the client setting.
3. Save. When any of the user’s selected options match any of the options selected on a requisition, then a

MyReq relationship is established. (The system will not attempt to match All.)

Edit User – BrassRing Admin+ Users
After the req field is selected in the client setting, in the user’s profile you can set the options that will create the
My-Req relationship when those options are selected on a Req. This can also be done in Workbench.

BrassRing > Admin > Admin+ > Users >

1. Click Edit icon for the selected user.

2. Click List>> and select desired options from the Req field selected in the client setting.
3. Save. When any of the user’s selected options match any of the options selected on a requisition, then a

MyReq relationship is established. (The system will not attempt to match All.)

Req Form Fields – Workbench Self-Service (Tiers 1+)
Once the client setting is enabled, ensure the selected field is present on desired req forms. You can add it
using:

Tools > Forms > Reqs > Req forms > Administer req fields

Notes for Integrations
You can set the req field options for only one user at a time in Workbench > Tools > Users or in BrassRing >
Admin, but can set for multiple users through user profile imports/integration XML uploads.

For integration XML uploads:

 If ReqPrivileges node is included but no Req field is selected for the ReqPrivileges client setting,
functionality is not enabled and an error will be presented.

 If the option provided in the node is not an option of selected question, an error will occur.
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The general XML for this node is:

<ReqPrivileges>

<Privilege>

</Privilege>

<Privilege>

</Privilege>

</ReqPrivileges>

 Option value is expected as code
 Both active and inactive options will be processed.

Potential privileges include the standard set of My Reqs/My Reqs 2 view privileges:

 My reqs – view approved
 My reqs – view cancelled
 My reqs – view closed
 My reqs – view declined
 My reqs – view deleted
 My reqs – view on hold
 My reqs – view open
 My reqs – view pending
 My reqs – view Evergreen req archived folder
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Rules Automation Manager – Internal Feature
Enhancements

Release 13.4 Rules Automation Manager (RAM) contains additional automated functionality to further
streamline the hiring process and allow more efficient configuration and troubleshooting.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

LDP 015

 BrassRing Workbench Internal

Visible Changes  No – RAM currently for internal use.

How do I get this feature?  Contact our Support Team for Rules Automation configuration.

Feature Description
Key feature of Release 13.4 Rules Automation Manager (RAM) Phase 8 include:

 Transitioning of trigger functionality offered by Automation Manager into RAM to provide scalability and
stability.

 Agency Contact is now available as a recipient type for Send communication actions.
 New warning messages inform Workbench users about various restrictions when they are creating RAM

triggers.

Transitioning of Automation Manager Triggers

The functionality offered by Automation Manager triggers is being transitioned into RAM architecture to provide
improved scalability and stability. Automation Manager trigger configuration and user interface remain
unchanged, but the following triggers use the RAM service broker queue to run:

 Candidate HR Status - send Talent Record (TriggerType=5)
 Talent Record Viewed - update HR Status (TriggerType=3)
 HR Status update - notify candidate(TriggerType=6)
 Assessments Reminders (TriggerType=8)
 Update HR Status Across all Reqs for Candidate in Final HR Status (TriggerType=9)
 Gateway Posting Expire (TriggerType=4)
 Candidate HR Status Aging (TriggerType=2)
 Req Aging (TriggerType=1)

Send Communication Agency Contact

You can now select Agency Contact as recipient type for Send communication actions (Tools > Automation
Manager -> Admin -> RAM Trigger -> Add/Edit -> Actions -> Send communication).

 If one agency owns the candidate at the candidate level, RAM uses the agency contact stored at the Talent
Record to send out email.

 If no agency contact is stored at Talent Record level, then RAM uses the agency contact who submitted for
that req so long as there is a req context in RAM and ownership is still valid for that req. Otherwise RAM
ignores that action by not sending any communication.
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Warning Messages

New warning messages inform Workbench users about various restrictions when they are setting up RAM
triggers and associated rules and actions. Messages are displayed in red in Workbench. Following are the new
messages in various scenarios:

The following warnings display on the “create RAM trigger” screen. For the count, only Active triggers are
considered.

 Warning: If you plan on creating more than 25 rules or 50 actions within a rule, please follow up with RAM
subject matter experts prior to this trigger creation to ensure your configuration is appropriate. If you ignore
this threshold and this trigger causes performance problems, the trigger will be automatically disabled.

 Warning: This is trigger #xx(number displayed here), which is beyond the common threshold of yy (where yy
is 50 for multi-tenant clients and 250 for single-tenant clients; yy is populated dynamically according to the
database the client is on). Please follow up with RAM subject matter experts to ensure your configuration is
appropriate. If you ignore this threshold and this trigger causes performance problems, the trigger will be
automatically disabled.

The following warning is displayed when you add a new rule and the threshold is exceeded.

 Warning: This is rule #xx(number displayed here), which is beyond the common threshold of 25. Please
follow up with RAM subject matter experts to ensure your configuration is appropriate. If you ignore this
threshold and this trigger causes performance problems, the trigger will be automatically disabled.

The following warning is displayed on the “add New Action” screen when you add a new action and the
threshold is exceeded, except for the auto-fill field population action.

 Warning: This is action #xx, (number displayed here) which is beyond the common threshold of 50. Please
follow up with RAM subject matter experts to ensure your configuration is appropriate. If you ignore this
threshold and this trigger causes performance problems, the trigger will be automatically disabled.

The following warning is displayed on the trigger activation screen with the other messages. The rules, actions,
or triggers that begin with # are displayed only when they are beyond the threshold.

 Warning: This trigger configuration is beyond the common threshold limits.

# Rules: xx(number displayed here)

Rules Common Threshold: 25

# Actions: xx(number displayed here)

Actions Common Threshold: 50

# Triggers: xx(number displayed here)

Triggers Common Threshold: yy (where yy is 50 or 250 for multi-tenant or single-tenant clients,
respectively).

Please follow up with RAM subject matter experts to ensure your configuration is appropriate prior to
activating. If you ignore this threshold and this trigger causes performance problems, the trigger will be
automatically disabled.

How Do Clients Get this Feature?
RAM requires the restricted Rules Automation Manager client setting to be turned on.

Also note that the client setting “RAM - Allow HR status update for closed reqs in HR status req options trigger"
was changed to "RAM - Allow HR status update for closed reqs." In line with the change in client setting, the
scope of updating the HR status of candidates in closed requisitions was extended. HR Status update of
candidates in closed requisitions can now be performed using all trigger mechanisms. Previously it was limited
to the “HR Status Req Options” trigger mechanism only.
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The RAM User Guide contains material to guide staff on the creation and maintenance of Rules Automation
Manager (RAM) triggers in Workbench.
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Single Sign On – SAML Enhancements

With this project, the SAML vendor DLL version is enhanced to 2:5:0:5 and some additional enhancements are
made.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

LDP 203

 BrassRing

 Talent Gatewaysl

 Other

Visible Changes  No – requires specific conditions / configuration for visibility.

How do I get this feature?  Automatic – see details below.

Feature Description
Previously, BrassRing supported the SAML 2.0 with the vendor DLL version 2:0:0:5. With this project, the
vendor DLL with newer version 2:5:0:5 also becomes available.

This new version:

 Ensures SAML 2.0 integration with 2048 certification support.
 Ensures better integration with SAML 2.0 as certain issues/bugs are fixed by the vendor.

This newer version DLL will also support the existing features, providing backward compatibility for features
such as:

 Deep links
 Test harness
 Special handling areas

eLink and DeepLink Differentiation

A new token column is used in version 2:5:0:5 to differentiate between eLinks and DeepLinks when the SP URL
or query tag doesn’t include a token. The Configuration Tasks section includes additional details.

BrassRing and BrassRing Talent Gateway Differentiation

Version 2:5:0:5 can also differentiate between BrassRing and Talent Gateway when redirecting users on logout.
The Configuration Tasks section includes additional details.

How Do Clients Get this Feature?
This new version is added by a backend setting and there is no change pertaining to Workbench UI. Please
contact our Support Team for more information about enabling this feature.
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Configuration Tasks

Currently the SSO TG’s do not make any SAML logout request. To address this issue, when logout URL is
clicked, control will be routed to an intermediate IBM Kenexa BrassRing page. In that URL’s query string, client
may code to which page it must be finally routed.

eLink and DeepLink Differentiation

To differentiate between eLink and DeepLink, a new token column, Kenexa entityid, is added in the
Hireflow.SamlIssuers table.

 If the SP URL or the query tag has a token, the token is considered to identify eLink or DeepLink (this is
existing functionality).

 If the SP URL or query tag doesn’t have a token, but the new “Kenexa entityid” column contains a token
value, then that stored token value determines if it is an eLink or DeepLink.

 If the SP URL or query tag doesn’t have a token, and the new “Kenexa entityid” column is blank, current
behavior continues (eLink or DeepLink is not determined).

BrassRing and BrassRing Talent Gateway Differentiation

To differentiate between BrassRing and Talent Gateway on logout, system will check the presence of “user id
token” and will redirect by appending the new query string to the existing SSO logout URL. BrassRing/Talent
Gateway will replace the "[USERID_TOKEN]" string with "&UserId=logged in userid" and then redirect.

BrassRing

For the given userid, integration page will read username from Users table (Express db) and pass that in SAML
log out call.

BrassRing Talent Gateway

For the given bruid, integration page will read ssoid from SsoTGProfiles table (TG_Candidate db) and pass that
in SAML log out call.
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Social Media – API Key Configuration

Clients using Social Media to share jobs and attract candidates are recommended to create their own API keys
on various Social Media websites and configure those keys in BrassRing Workbench for their use with the
BrassRing application. This assists with performance during peak hours, especially with LinkedIn.

IBM® Kenexa® BrassRing® on Cloud Release 13.4.2

Feature Areas

RDP 1070

 BrassRing Workbench Self-Service

Visible Changes  Yes – details in Visible Changes document.

How do I get this feature?  Specific conditions required – see details below.

Feature Description
Clients can now create individual API keys for Social Media websites. Prior to this release, a static API key was
used for all social media sites, which at times resulted in errors during peak traffic hours. The creation of
individual API Keys will help distribute the traffic, resulting in a smoother candidate experience.

Best Practice Recommendations

Best practice is to create three different pairs of API Key and Secret Key combinations.

How Do Clients Get this Feature?
Clients with the Enable Social Media integration client setting set, for one or more of the social networking sites,
create individual API keys for desired sites. The keys must then be configured in Workbench. If your
organization does not have a Workbench administrator, your IBM Representative can assist you.
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Configuration Tasks

Clients first create an API for the desired social media sites:

 LinkedIn
 Facebook
 Twitter

Keys obtained during API creation must then be configured in Workbench.

Creating API for LinkedIn
Following steps help you to create API for LinkedIn.

1. Go to https://www.linkedin.com/secure/developer

 If you already have a LinkedIn account, click “Sign In”.
 If you do not have an account, click “Join LinkedIn” to create a new account.

2. Click “Add New Application” to add the application for which an API key needs to be created.
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3. Enter the details in the application form opened.

 Company Name and Description
 Application Name in the format CompanyName_Brassring
 Website URL for your career page URL
 Application Use, for example, select Jobs and Recruiting

 Default Scope = r_fullprofile, r_contactinfo, r_emailaddress, rw_nus
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 App Logo Secure URL - enter the link for displaying your logo
 Agreement Language = Browser Locale Setting
 Terms of Service – click Agree

4. Click Add Application to create the application. A confirmation message is displayed along with the API and
secret keys.

5. Note the generated API Key and API Secret Key so they can be provided in Workbench in LinkedIn’s
Administer configuration page.

6. You may choose to use one API key and Secret Key pair for all three combinations, but it is a best practice
to create three different pairs. To do so, repeat this process to obtain two additional key pairs.

7. On the LinkedIn Developer profile, the newly created application appears in the list of applications.
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8. To retrieve the API Usage report, at any time, click “View API Usage” in the List of Applications screen.

An advantage of creating your own LinkedIn app is that, candidates and users see your brand and app name
instead of BrassRing's brand on the authorization screen.

Creating API for Facebook
The following steps help you in creating an API for Facebook:

1. Login to your Facebook account.
2. Scroll to bottom and click “Developers” hyperlink.

136 of 186



© Copyright IBM Corp. 2014 Social Media – API Key Configuration | 6

3. Go to Apps > Register as a Developer. Enter your Facebook password for confirmation if it is requested.
(If you are already a registered developer, “Create a New App” is displayed; skip to step 8.)

A pop up “Register as a Facebook Developer” is displayed.

4. Click “YES” to accept the policy and then click “Next.”
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5. To register:

1. Select country.
2. Enter phone number, which is requested to verify your account.
3. Click Send as Text or Send voa Phone Call to receive a code that is sent to this phone number for

confirmation. The entered number will be added to your timeline but will not be visible to your friends.
4. Enter the confirmation code received.
5. Click Register.

6. After successful registration, a pop up is displayed. Click “Done”.

7. Go to Apps > Create a New App.
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8. Enter the App details:

1. Display Name = Company name_BrassRing
2. Category = Business
3. Read the policies.
4. Click Create App.

9. For security check, enter the text that is displayed on the screen in the text box and click “Submit.”
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10. App is created with the “Display Name” you have saved. Click “Show” to view the “Secret Key.”

11. When prompted, re-enter your Facebook password and click “Submit”.
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12. Secret Key is now displayed on the screen.

 Note the generated API Key and API Secret Key so they can be provided in Workbench in Facebook’s
Administer configuration page.

 Click Settings tab.

13. Under Basic settings, add a valid contact email address and click “+Add Platform.”

14. In the Select platform popup, select “Website.”

141 of 186



© Copyright IBM Corp. 2014 Social Media – API Key Configuration | 11

15. In the “Basic” tab, enter the appropriate URL in the “Site URL” field; depending on the BrassRing
environment your organization/client is creating this app for. Click Save Changes.

16. In the “Advanced” tab, under the “Security” section, select “YES” for Client OAuth Login and Embedded
browser OAuth Login fields. Remaining fields can be left as they are with the default values. Click Save
Changes.
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17. Click App Details tab to update your company details.

 Enter your company-specific URLs.

 Upload your company’s logo.
 Click Save Changes when done..
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18. Click “Status & Review” tab.
Click “YES” for when queried if you want to make the app public .
Click “Confirm” in the pop up window.

19. You may choose to use one API key and Secret Key pair for all three combinations, but it is a best practice
to create three different pairs. To do so, repeat this process to obtain two additional key pairs.

The advantage of creating your own Facebook app is that candidates and users see your brand instead of
BrassRing's brand on the authorization screen.

Creating API for Twitter
The following steps help you in creating an API for Twitter:

1. Open the following website for Twitter and click “sign in.” Provide your Twitter credentials.
https://apps.twitter.com/
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2. Click “Create New App.”

3. Fill the details in the application form: Application name and description, Website for your organization,
Callback URL, choosing from:

 https://sjobs.brassring.com/tgwebhost/
 https://sstagingjobs.brassring.com/tgwebhost/
 https://krb-sjobs.brassring.com/TGWebHost/
 https://stagingkrb-sjobs.brassring.com/TGWebHost/
 https://krbcn-sjobs.brassring.com/tgwebhost/
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4. Check if you agree with the terms and click Create your Twitter application.

5. Your app is successfully created and the API key is displayed. Click “modify app permissions.”
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6. You are routed to Permissions tab.

 Select the “Read and Write” option.
 Click “Update Settings.”

7. Click API Keys tab. The API key and Secret Key are displayed in the “Application Settings” section.

8. Note the generated API Key and API Secret Key so they can be provided in Workbench in Twitter’s
Administer configuration page.-

9. You may choose to use one API key and Secret Key pair for all three combinations, but it is a best practice
to create three different pairs. To do so, repeat this process to obtain for two additional key pairs.

Social Media Configuration – Workbench Self-Service (Tiers 7+)
For each social media site, three (3) API Key and Secret Key combinations can be obtained and added in
Workbench. You can choose to use one API key and Secret Key pair for all three combinations, but it is a best
practice to create three different pairs. Configure the API keys in Workbench (examples shown in preceding
steps for each site):

Tools > Settings > Social Media Configuration > Administer configuration [for selected social site]
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LinkedIn Sample

Enter the keys in the section “API Keys for Social Networking.” (The Cross System API Key is reserved for the
separate cross-system awareness feature.)

Facebook Sample
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Twitter Sample

After you configure the new keys from the social media sites within Workbench, all of your BrassRing users, as
well as candidates, will have to once again authorize BrassRing. The advantage with this change is that
candidates and users see your organization's brand instead of BrassRing's brand on the authorization screen.
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IBM® Kenexa® BrassRing® on Cloud Browser/OS Support

Whenever you need the most up-to-date information on supported platforms and browsers, please see the
Browser/OS Support document on the User Resource Center.

IBM® Kenexa® BrassRing® on Cloud Language Support

Whenever you need the most up-to-date list of supported languages, please see the Language Support
document on the User Resource Center.

Support for the following languages was added in Release 13.4 for BrassRing, BrassRing Talent Gateways, and
BrassRing Agency.

 Thai (Project LDP 193)
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Talent Gateways – Browser Support Information

A text customization configuration will display a hyperlink to the Browser Support statement on various pages of
the IBM® Kenexa® BrassRing® on Cloud Talent Gateways.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

RDP 743

 Talent Gateways Workbench Self-Service

Visible Changes  No – requires specific conditions / configuration for visibility.

How do I get this feature?  Configuration required – contact our Support Team for
implementation details.

Feature Description
Candidates access BrassRing Talent Gateways using various web browsers. If their browser is not supported by
the BrassRing Talent Gateway, they might face issues or be unable to complete their application. To provide
help in this regard, a hyperlink to a support document can be posted across various pages of the BrassRing
Talent Gateways and BrassRing Talent Gateway Questionnaires by configuring the existing BrassRing Talent
Gateway text customization.

Candidates can access this hyperlink and find help regarding the supported web browsers that they can use to
complete their application.

Candidate Experience

Candidates see a hyperlink available on specific pages of the BrassRing Talent Gateway. Clicking this hyperlink
opens a standard browser support document.

Policy Statement

The following text is from the current standard support statement; links (indicated in the following statement by
inactive underlining) take readers to the corresponding browser-developer Web site. Browser versions in the
statement will be updated periodically.

Browser Support Statement

We recognize that our visitors may have various operating systems and Internet browsers. Although we want
every visitor to have the best possible experience on our website, we understand it is impossible to provide web
pages that work identically, efficiently, and effectively with all browsers and settings.

This website has been tested compatible using desktop versions of most heavily-adopted browsers:

 Internet Explorer 7.0 and higher*
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 Mozilla Firefox 4.0 and higher*
 Safari 4.0 and higher*
 Google Chrome 12 and higher*

*Latest versions of the browsers will be supported close to the time of their release

For optimal viewing, please set your screen resolution to at least 1024 X 768 and have JavaScript enabled.

Mobile Apply
Applying for a job using a mobile device is supported on mobile devices using Android 2.1 and higher and on
Apple iOS4 and higher.

Having trouble accessing our website?
Updating your browser will likely fix any compatibility issues you are currently experiencing. Below are links to
the browser developers’ websites.

 Internet Explorer
 Mozilla Firefox
 Safari
 Google Chrome

How Do Clients Get this Feature?
This feature is controlled by Talent Gateway Text customization.

Please contact our Support Team or your Certified Workbench User for more information.
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Configuration Tasks

This section describes the tasks required to configure this feature. Tasks labeled Workbench Self Service can
be performed by certified Workbench Self Service users or by our support staff.

Talent Gateway Text Customization – Workbench Self-Service (Tiers 1+)
The hyperlink for the browser support document can be added in the following areas:

 Landing page
 Login page of Talent Gateways and Gateway Questionnaires
 Create Login page of Talent Gateways and Gateway Questionnaires
 QuestionnaireLogin/Create Login pages

For example, your organization could add a text string to the “Welcome text” text customization string on the
Landing page, such as:

To view our browser support policy, [Click Here #BrowserSupportStatement#]

To customize the text, navigate to:

Workbench > Tools > Talent Gateways > Text customization [for selected Talent Gateway] > [one of the
following tabs]

To display the hyperlink, you can configure the token on the following tabs in any of the listed text customization
settings:

 Landing

 Welcome text
 Search openings summary text
 Site general submission summary text
 Log in summary text
 Featured job intro text

 Create login

 Create login intro text

 Log in

 Log in intro text

 Gateway Questionnaire log in/create

 Gateway Questionnaire log in/ create log in intro text
 Gateway Questionnaire custom navigation text
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Talent Gateways – Send to Friend Button

This feature allows IBM
®

Kenexa
®

BrassRing
®

on Cloud candidates to email job postings to friends using the
Send to Friend button on the Search results or the Job details page.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

RDP 891

 BrassRing

 Talent Gateways

Workbench Self-Service

Visible Changes  No – requires specific conditions / configuration for visibility.

How do I get this feature?  Configuration required – contact our Support Team for
implementation details.

Feature Description
This feature restores the ability for BrassRing candidates to email job postings to friends from either the Search
results or Job details page. Minor changes streamline Subject and Message handling.

When candidates click the Send to Friend button during the job application process, an email dialog box
launches, prompting the candidate for sender and recipient email addresses and recipient's name (subject and
message labels are now hidden). Candidate then clicks Send e-mail.

The email recipient receives the email displaying:

 subject line containing the default or customized text (configured for the TG in Workbench, for the TG
Search results or Job details page)

 email containing customized tokens (sourced from Workbench) that include links to the recommended job
posting(s)

 Clickable View details link to view and apply to job.

Customized Send to Friend message text can be configured for Talent Gateways in
Workbench, or accounts can use default text.

154 of 186



© Copyright IBM Corp. 2014 Talent Gateways – Send to Friend | 2

Candidate Experience

Candidates access the Send to Friend functionality on either the Search results or Job details page if text
customization is configured for both Job pages. This example outlines the process for candidates using the
Send to Friend button on the Search results screen.

1. Candidate begins job search.
2. Candidate sees suitable job (or jobs) for a friend.

3. Checks the checkbox for one or multiple job postings.
4. Clicks the Send to Friend button on the Search results screen.

The Send to Friend email dialog box launches:

5. Candidate inputs their email address (Sender), the Recipient email address, and the Recipient's name. The
Recipient name field character limit is 25 alpha characters including spaces.
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Candidates cannot use Copy and Paste when entering Recipient's name.

6. Clicks Send e-mail.

Candidate receives confirmation email.

Configuring this feature does not change other friend text customization fields or
settings on Workbench.

How Do Clients Get this Feature?
This feature is controlled by a special configurations setting, Disable Send to a Friend, which must be
unchecked in Workbench. Talent Gateway text customization for the TG offers flexible messaging. Please
contact our Support Team or your Certified Workbench User for more information.

This feature is available on non-WCAG and WCAG Talent Gateways.
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Configuration Tasks

To configure this feature:

1. Uncheck the "Disable Send to a Friend" Talent Gateway setting in “Special configurations” section
(Workbench > Tools > Talent Gateways > Edit [selected TG]).

2. Customize Send to Friend text on the desired TG pages (see following).

Talent Gateway Text Customization – Workbench Self-Service (Tiers 1+)
To associate the TG text customization with the Send to Friend button for both the Search results and Job
details pages, enter text customizations on both the Search results tab and the Job details tab for the Talent
Gateway.

Use this procedure to associate Talent Gateway text customization to both the Search results and Job details
pages Send to Friend button.

1. Workbench > Tools > Talent Gateways > Select your Gateway and click the Edit Text Customization
icon to launch the Talent Gateway text customization page.

2. Click the Search results tab.

 Enter up to 250 characters in the Send to friend E-mail Subject text box on the Search results tab.
This customized text displays in the email subject line. Click the Reset to Default button to restore
default text: Jobs at [#clientname#].

3. (Optional) Enter text customization for the Send to Friend button text.

4. Click Save.
5. Select your Gateway and click the Edit Text Customization icon to re-launch the Talent Gateway text

customization page.
6. Scroll to the Job details tab.
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7. Enter up to 250 characters in the Send to friend E-mail Subject text box on the Job details tab. This
customized text displays in the email subject line. Click the Reset to Default button to restore default text:
[#jobtitle#] at [#clientname#].

8. (Optional) Enter text customization for the Send to Friend button text.
9. Click Save.
10. (Optional) Navigate to the Notifications Tab and enter text customization for Send to Friend Email text.

11. Click Save.
12. Click Synchronize changes with Talent Gateways.

To verify your changes if desired, click the Launch Talent Gateway icon and perform a search (logged-in or not
logged- in) to see the “Search results” page for the TG. Select a job to view “Job details” page.
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Web Service API – Additions and Enhancements

The following list outlines additions and enhancements to IBM
®

Kenexa
®

BrassRing
®

on Cloud existing
Application Programming Interfaces (APIs) in Releases 13.4. For detailed information, see IBM Kenexa
BrassRing on Cloud API Reference – Candidate-Specific APIs and Web Service API on the User Resource
Center (URC).

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

RDP 756, 885

 BrassRing

 Talent Gateways

 API and Web Services

Visible Changes  No – requires specific conditions / configuration for visibility.

How do I get this feature?  Configuration required – contact our Support Team for
implementation details.

Features List
This document presents a brief overview of the API enhancements introduced in Release 13.4. Each new
feature requires specific configuration. Please contact your Support Team for more information about enabling
these features.

Candidate APIs

Candidate specific APIs are APIs that directly support a candidate’s interactions with a client’s talent gateway or
job search website. Candidate APIs allow candidates to perform tasks related to their job application process.

Release 13.4 introduces this Candidate API enhancement:

Changing Secret Questions and Answers - This project enhances the TG Candidate API by adding the ability to
change the security question(s) and/ or answer(s) from a client's BrassRing talent gateway website.

Clients must enable the Enhanced Self-service login management to access three
securityQIDs and Answers with this API.

BrassRing Talent Gateway Job Search API

Talent Gateway APIs are APIs that support job search functions and determine how a client's content is
delivered to their talent gateways or websites.

Release 13.4 introduces this Job Search API enhancement:

Return Unposted Jobs – A new node, ReturnUnpostedJobs, within the TG Job Search API allows clients to
retrieve and display unposted jobs.

Changing Secret Questions and Answers
This feature adds a new API call operation to change secret questions and answers for authenticated
candidates. Authenticated candidates can now change their secret questions and answers when logged onto a
client's talent gateway website.

 If Enhanced Self-Service Login Management is disabled on talent gateways, only one SecurityQID &
Answer is required.
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 If Enhanced Self-Service Login Management is enabled on talent gateways, all three SecurityQIDs &
Answers are required in order to change any secret questions and answers.

 The existing security questions & the corresponding answers are replaced with the new values sent in
the xml.

Web service parameters must include:

Operation Name:

ChangeCandidateSecurityInfo

Data Required in Web Service Request Call:

 Candidate Authentication Token
 SecurityQID
 Answer

Data Returned in Web Service Response

This operation returns a ‘Success’ or Failure’ status response.

Candidate Experience

Candidates can now change their security question or questions when logging onto a client's custom user
interface.

Potential error responses/scenarios as follows:

 Authentication node cannot be empty or missing.
 Invalid Security Questions
 SecurityInfo node is missing
 Security questions do not match
 SecurityQID is missing
 Answer node is missing
 Value not supplied for the answer
 Security question cannot be configured again

Target Users

Clients providing a custom candidate experience.

How Do Clients Get this Feature?

This feature requires Candidate API configuration. Please contact your Support Team for more information
about enabling this feature.

Refer to the IBM
®

Kenexa
®

BrassRing
®

API Reference – Candidate-Specific APIs and Web Service API on the
User Resource Center for full configuration information.

For information related to TG Login Details Management refer to Product Update Guide (PUG) located on the
User Resource Center (URC).

BrassRing Talent Gateway Search API Enhancement
This enhancement introduces a new API call operation, 'ReturnUnpostedJobs,' to the TG Job Search API. For
clients using a third-party vendor, the ReturnUnpostedJobs method retrieves and displays unposted jobs for
time periods specified in the API call. This is an optional node within a job search API call.
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If a client wants to view unposted jobs for the last month the ReturnUnpostedJobs API call can retrieve and
display unposted jobs within specified time frames and view when the jobs were unposted (date and time
stamped).

For example, if a client currently has 50 job results posted on their website but has 10 unposted jobs, including
the ReturnUnpostedJobs node within the API call allows clients to retrieve only the unposted jobs.

A max of 25,000 posted and unposted jobs can be accessed via the API call. If the return value exceeds more
than 25,000 jobs the returned jobs are based on most recent.

Web service parameters must include:

Operation Name:

ReturnUnpostedJobs

DatePosted

Data Required in Web Service Request Call:

This is an optional node within the job search API call. ReturnUnpostedJobs API call can include the following
values:

Yes initiates the API call and is case sensitive.

DatePosted – All or specific date (yyyy-mm-dd)

When the API call contains a specified date, the API call response returns all unposted jobs after the specified
date.

Data Returned in Web Service Response

ReqID

DateTimeUnposted

Success/Status

BrassRing User Experience

Clients can now retrieve and display unposted jobs.

Potential error responses/scenarios as follows:

 ReturnUnpostedJobs element only accepts a Yes value.

Target Users

Clients requiring access to unposted jobs.

How Do Clients Get this Feature?

This feature requires Job Search API configuration. Please contact your Support Team for more information
about enabling this feature.

Refer to the IBM
®

Kenexa
®

BrassRing
®

API Reference – Candidate-Specific APIs and Web Service API on the
User Resource Center for full configuration information.
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Workbench – Exporting HR Status to Excel

IBM® Kenexa® BrassRing® on Cloud Workbench users can now export to Microsoft Excel a listing of BrassRing
HR statuses and their settings. This is particularly useful for organizations with large numbers of HR statuses to
manage.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

LDP 071

Workbench Workbench Self-Service

Visible Changes  No – changes in Workbench only.

How do I get this feature?  Automatic – see details below.

Feature Description
For HR statuses, the existing Export to PDF action exports only the HR status previous and next statuses to a
PDF. Now Workbench users can export all HR statuses and all their attributes to Microsoft Excel format, with
the attributes visible in their own columns. This “point in time” snapshot of the HR status configurations allows
administrators to evaluate any future changes to HR statuses and their impact on the system.

.

This export from Workbench is available as an action from the HR Status administration page, called Export
to Excel. When the export has been processed, Task Manager sends an email to the initiating user that
indicates the export task has completed, and provides summary information (success/failure, job dates, rows
processed, retrieval/error information).

Workbench users who can export include certified Self-Service Tiers 5+, Tech Services, Super Users, and
Partner Users. Note that here is no corresponding import available for this HR Status export.

Workbench User Experience

Initiating the Export

1. In Workbench, navigate to Tools > HR Statuses.
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2. To queue the export, click Export to Excel; you do not have to select an HR status. All active and inactive
HR statuses are exported, regardless of filter or search results.

3. On the pop-up, enter a name for your export task and click Launch.
4. A pop-up message informs you that your export has been added to the task manager.

Retrieving the Export

Task Manager sends an email to the initiating user when the export task has completed.

The email subject indicates success or failure, and the message includes: Task name, environment, client
name, date/times the task was submitted, started, and finished, number of rows processed. In cases where the
export succeds,the messages includes a pointer to Task Manager to retrieve; for failed exports, the message
includes error messaging.
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5. To retrieve the report, go to Tools > Task Manager.

Status column for your HR status export indicates whether the job is Pending, Running, Completed, Failed
(for example, due to code error, timeout, database server unavailability, etc.), or Suspended.

6. To download the file for a “Completed” (or “Completed with errors”) export, click its View icon. A popup
dialog gives you the option to open or save the file.

Viewing the Output File

When you open the Microsoft Excel export file, the Properties tab includes information similar to what was
included in the email from Task Manager: Task name, environment, client name, rows processed, date/times
the task was submitted, started, and finished.
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The HR Statuses tab contains the data for all HR statuses and their attributes.

 Optional fields are blank in the export unless otherwise noted
 Values in HR status name Translations, Valid after, Next statuses columns are not sorted
 All group value columns in the Excel file will end with a semi-colon. This is to maintain similar behavior as all

other reports. Semi-colon will be displayed at the end even if only one value exists in the group value
column (including for Valid after, Next statuses column

Best Practices: Immediately upon opening export file in Excel:

 Freeze top row
 Utilize Data > Filter (or ‘autofilter’). Users can utilize the filters in Excel to view specific statuses and/or

attributes for comparison.

Output Details

Column Data/Business rules

HR status name Required. Name of HR status in default locale

Status Required. Active; Inactive

Type Required. Start; Intermediate; Final

Placement Required. Number of position in HR status listing

HR status name (and
translations)

Optional. Translations of HR statuses with locale in parenthesis separated
by semicolons

Number of candidates
currently in this status

Required. If there are no candidates currently in this HR status, the value
exported will be ‘0’.

Show status at 0-Filed
Optional. Checkbox type field in interface.If the setting is NOT checked, it
will be blank. Will be ‘Yes’ for all Start statuses.

Valid After

Required for Intermediate and Final statuses. HR statuses that this status
can follow, separated by semicolons. Will be blank for Start statuses. If
Tracking Logic is Open, then will display ‘<<Tracking logic is open>>’ for
start, Intermediate and Final statuses.

Next statuses

Required for Start and Intermediate statuses. HR statuses that can follow
this status separated by semicolons. Will be blank for Final statuses. If
Tracking Logic is Open, then will display ‘<<Tracking logic is open>>’ for
Start, Intermediate and final statuses.

Agency mask
Optional. Name of BrassRing Agency mask (if any). If no value, export
value will be blank.
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Talent Gateway Reapply
setting Status allows for
reapplies

Optional. Checkbox field type in interface If setting is checked, export
value will be ‘Yes’. If setting is unchecked, export value will be ‘No.’ Export
value will be ‘No’ for Start statuses.

Talent Gateway Reapply
setting Designated Reapply
status

Optional. Checkbox field type in interface If setting is checked, export
value will be ‘Yes.’ If setting is unchecked, export value will be ‘No.’ Export
value will be ‘No’ for Start and Final statuses.

Referral/Status check
screen Talent Gateway
mask

Optional. Name of Talent Gateway mask (if any). If no value, export value
will be blank.

Referral/Status check
screen Display job/referral
status information

Optional. Checkbox field type in interface If setting is checked, export
value will be ‘Yes.’ If setting is unchecked, export value will be ‘No.’

Block job submission
withdrawal when
withdrawing candidate is at
this HR status

Optional. Checkbox field type in interface If setting is checked, export
value will be ‘Yes.’ ’If setting is unchecked, export value will be ‘No.’

Block job submission
reactivation when any
candidate in req folder is at
this HR status

Optional. Checkbox field type in interface If setting is checked, export
value will be ‘Yes.’ If setting is unchecked, export value will be ‘No.’

Pop up form
Optional. If populated, export value will be Display form name. In case the
form is inactive, then the status will be appended in parentheses at the
end.

Email Optional. If populated, export value will be an email address.

Include in 'Respond to
eLink' list of HR statuses

Optional. Checkbox field type in interface If setting is checked, export
value will be ‘Yes.’ If setting is unchecked, export value will be ‘No.’

Convert Candidate Type

Optional. Single-select drop down of candidate types in interface. If setting
is populated, export value will be the candidate type. If setting is
unpopulated, the export value will be blank. The setting will be blank for
Start and Intermediate statuses.

Count down positions
Optional. Checkbox field type in interface If setting is checked, export
value will be ‘Yes.’ If setting is unchecked, export value will be ‘No’. The
setting will be ‘No’ for Start and Intermediate statuses.

Automatically Close filled
requisitions

Optional. Checkbox field type in interface If setting is checked, export
value will be ‘Yes.’ If setting is unchecked, export value will be ‘No’. The
setting will be ‘No’ for Start and Intermediate statuses.

HR Status Aging: Days in
status that is acceptable

From <from value> to <to value>; Trigger for My Task Panel : <Yes/No>

HR Status Aging: Days in
status that is cautionary

From <from value> to <to value>; Trigger for My Task Panel : <Yes/No>
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HR Status Aging: Days in
status that is unacceptable

From <from value> to <to value>; Trigger for My Task Panel : <Yes/No>

Interview Builder - Select
Req field

Optional. Export values will be blank if the client setting ‘Integration
Interview Builder’ is not enabled. Single Select drop down field type in
interface. If setting is populated, export value will be the display req field
name. If setting is unpopulated, export value will be blank.

Interview Builder - Redirect
options - Automatic
Redirect for Print/Send

Optional. Export values will be blank if the client setting ‘Integration
Interview Builder’ is not enabled. Checkbox field type in interface If setting
is checked, export value will be ‘Yes.’If setting is unchecked, export value
will be ‘No.’

Interview Builder - Redirect
options - Automatic
Redirect for Score

Optional.Export values will be blank if the client setting ‘Integration
Interview Builder’ is not enabled. Checkbox field type in interface If setting
is checked, export value will be ‘Yes.’If setting is unchecked, export value
will be ‘No’

Interview Builder -
Print/Send or Score
Interview

Optional. Export values will be blank if the client setting ‘Integration
Interview Builder’ is not enabled. Checkbox field type in interface If setting
is checked, export value will be ‘Yes.’ If setting is unchecked, export value
will be ‘No.’

Event Manager - Pass
resume key to Event
Manager

Optional. Checkbox field type in interface If setting is checked, export
value will be ‘Yes.’ If setting is unchecked, export value will be ‘No.’

Civil Service Register -
Send candidate to Civil
Service Register

Optional. Export values will be ‘No’ if the client setting ‘Civil Service
Register’ is not set to ‘Yes’. Checkbox field type in interface If setting is
checked, export value will be ‘Yes.’ If setting is unchecked, export value
will be ‘No.’

Civil Service Register -
Update status in Civil
Services Register

Optional. Export values will be ‘No’ if the client setting ‘Civil Service
Register’ is not set to ‘Yes’. Checkbox field type in interface If setting is
checked, export value will be ‘Yes.’If setting is unchecked, export value will
be ‘No.’

Onboarding - Applicant
Selected, Proceed to
Onboarding

Optional. Export values will be ‘No’ if the client setting ‘Enable Onboarding
user authentication’ is not set to ‘KMS with auto-launch’. Checkbox field
type in interface If setting is checked, export value will be ‘Yes.’ If setting is
unchecked, export value will be ‘No.’

Hide candidates in HR
status in req folders for
these user types:

Optional. User types separated by semicolon.

User types that cannot
UPDATE candidates to this
HR status:

Optional. User types separated by semicolon.

User types that cannot
UNDO candidates to this
HR status

Optional. User types separated by semicolon.
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Block HR status update
when selected form(s) are
not attached

Optional. Checkbox field type in interface If setting is checked, export
value will be ‘Yes’. If setting is unchecked, export value will be ‘No.’

Block HR status update –
List of Form(s)

Will display form name(s) if export value is ‘Yes’ for Block HR status
update when selected form(s) are not attached column. Else the value
will be blank.

The form names will be separated by a semi-colon. There will be no
further separations based on forms selected for each individual rows. No
additional qualifiers will also be displayed

Block HR status update -
Enable Background
screening validation

Optional. Checkbox field type in interface If setting is checked, export
value will be ‘Yes.’ If setting is unchecked, export value will be ‘No.’

Block HR status update -
Forms requiring approval
need to be in an 'Approved'
status

Optional. Checkbox field type in interface If setting is checked, export
value will be ‘Yes.’ If setting is unchecked, export value will be ‘No.’

Block HR status update -
Error message (and
translations)

Optional. Text area field in interface. Default value is “Form(s) [insert
form(s) name] are required for the selected HR Status. Candidate(s)
missing the required forms may not be updated at this time.”

Block HR status update
when the req is not posted
for a defined period of time

Optional. Checkbox field type in interface If setting is checked, export
value will be ‘Yes.’ If setting is unchecked, export value will be ‘No.’

Block auto req cancellation
Optional. Checkbox field type in interface If setting is checked, export
value will be ‘Yes.’ If setting is unchecked, export value will be ‘No.’

Integration subscriptions
Optional. Any integration subscriptions that are ‘triggered’ on this HR
status, they will be exported with the value of the Integration subscription
name.

Triggers

Optional. If there are any RAM or Automation Manager triggers listed
under the ‘triggers’ section of the HR statuses, the values will be exported
separated by semicolons.

The export will also inform the user if the trigger is a condition/action or a
trigger mechanism. This will be indicated at the end of each bracket in
parentheses.

Panels
Optional. If there are any Panels listed under the ‘panels’ section of the HR
statuses, the values will be exported separated by semicolons.

Automatically file candidate
to Req folder by HR Status
through insta-file

Req template that names this HR status. In case the form is inactive, then
the status will be appended in parentheses at the end.

Manually file candidate to
Req folder by HR Status

Req template that names this HR status. In case the form is inactive, then
the status will be appended in parentheses at the end.
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Auto-send e-mail to
candidates in req folder by
HR Status

Req template that names this HR status (Req email template) (Candidate
types - all;<specific>)

If there are multiple Requisition templates, separate the information by
semi-colons. If Candidate Types = All, export the value ‘All’; If Candidate
Types = Specific, export the candidate type values selected separated by
semi-colons.

In case the form is inactive, then the status will be appended in
parentheses at the end.

How Do Clients Get this Feature?
This feature is available automatically in Workbench without configuration.
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Workbench – Exporting User Type Access to Excel

BrassRing Workbench users can now export to Microsoft Excel a listing of user type access. The listing covers
areas of IBM® Kenexa® BrassRing® on Cloud where user types affect behavior/access: HR status settings, Req
form fields, Candidate forms, Candidate form fields, Panel mappings, Privileges, Screen defaults, etc. Clients
can take advantage of Excel’s filter and analysis tools when reviewing the output and comparing settings across
user types.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

LDP 175

 BrassRing Workbench Workbench Self-Service

Visible Changes  No – changes in Workbench only.

How do I get this feature?  Automatic – see details below.

Feature Description
Workbench users can now export to Microsoft Excel a listing of user type access. The listing covers areas of
BrassRing where user types are in use: HR status settings, Req form fields, Candidate forms, Candidate form
fields, Panel mappings, Privileges, Screen defaults, etc. Clients can take advantage of Excel’s filter and analysis
tools when reviewing the output and comparing settings across user types.

This export from Workbench is available as an action from the User type listing page, called User type access
– Export to Excel. When the export has been processed, Task Manager sends an email to the initiating user
that indicates the export task has completed, and provides summary information (success/failure, job dates,
rows processed, retrieval/error information).

Workbench users who can export include certified Self-Service Tiers 1+, Tech Srevices, and Super Users.

Workbench User Experience

Initiating the Export

1. In Workbench, navigate to Tools > Users > User Types.
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2. To queue the export, click User type access – Export to Excel; you do not have to select a user type.
A pop-up message informs you that your export has been added to the task manager.

Retrieving the Export

Task Manager sends an email to the initiating user when the export task has completed.

The email subject indicates success or failure, and the message includes: Task name, environment, client
name, date/times the task was submitted, started, and finished. In cases where the export succeds,the
messages includes a pointer to Task Manager to retrieve; for failed exports, the message includes error
messaging.

3. To retrieve the report, go to Tools > Task Manager.

Status column for the listed User type access exports indicates whether the job is Pending, Running,
Completed, Failed (for example, due to code error, timeout, database server unavailability, etc.), or
Suspended.

4. To download the file for a “Completed” (or “Completed with errors”) export, click its View icon. A popup
dialog gives you the option to open or save the file.

Viewing the Output File

When you open the Microsoft Excel export file, the Properties tab includes information similar to what was
included in the email from Task Manager: Task name, environment, client name, rows processed, date/times
the task was submitted, started, and finished.
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The UserTypeAccess tab contains the data for all user types and the functional areas in the system impacted
by user types.

 Each setting has it’s own row; each user type has it’s own column (Yes/No)
 Allows for troubleshooting and/or comparing user types in the system
 Allows administrators and services to more effectively manage user types

Best Practices: Immediately upon opening export file in Excel:

 Freeze top row
 Utilize Data > Filter (or ‘autofilter’). Users can utilize the filters in Excel to view specific functional areas

and/or settings for user type access comparison.

Some filter examples are shown in the following figures.
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Sample Functional Area column filter

Sample Function column filter
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Sample Settings column filter

Output Details

Export files can get extraordinarily large. Export distributes very large exports into multiple files with a maximum
of 100,000 rows each.

Functional Areas

The list of Functional Areas includes:

 Candidate form
 Candidate form field
 Candidate type
 Custom help
 Document subsidiary form
 Document subsidiary form field
 HR status access
 Panel mapping
 Req form field
 Req Status change addendum field
 Requisition Subsidiary form field
 Screen display defaults
 User type privilege

Functions and Settings

The Function column identifies sub-area of the functionality, and the Setting column shows specific settings of
the functionality. Rows include:

 Candidate form (value is the database form name, including active and inactive forms)
Settings values include: Search, Output, Add / View / Modify My, View - my reqs,View all, Modify - my reqs,
Modify all, Save as draft - Save / modify / delete my, Delete all

 Candidate form field (value is database form name: Database field name, including active and inactive
fields)
Settings values include: Hidden, Non-editable, Required”
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 Candidate type
Settings values: User types can search candidate type

 Custom help
Settings values: 'My help' text configured for at least one language

 Document subsidiary form (if client has none, no rows exported
Settings values include: Search, Output, View all, Modify all, Delete all

 Document subsidiary form field
Settings values include: Hidden, Non-editable, Required

 HR status
Settings values include: Hide candidates in HR status, Cannot UPDATE to this HR status, Cannot UNDO in
this HR status

 Panel mapping (alphabetically by Panel Type name)
Settings values include: Panel_configuration_name

 Req form field (Standard and Custom fields for the requisition template, by placement order)
Settings values include: Hidden, Non-editable, Required

 Requisition Subsidiary form field
Settings values: Hidden

 Req Status change addendum field
Settings values: Hidden

 Screen display defaults (value is either “Talent Record” or “Resume/CV Section”)
Settings values for “Talent Record”: Allow users to edit display
Settings values for “Resume/CV Section” include: Contact Details: Display, Contact Details: Default,
Resume/CV: Display, Resume/CV: Default, Cover Letter: Display. Cover Letter: Default,
Experience/Education: Display, Experience/Education: Default

 User type privilege (value is User type privilege Function, for example, Candidate Actions 2, My Reqs)
Settings values include: Privilege

User Types

Each configured User Type has a column, which displays “Yes” if the Setting for that Function for that Functional
Area is enabled; otherwise displays “No.”

Limitations and Known Issues

Some less-frequently-used functions are not reported on:

 Candidate stacking field: Hide in BrassRing for these user types (Tools > Settings > Fields > Candidate
profile fields: Candidate stacking fields > Edit field attributes)

 Candidate Export integration: User types allowed to trigger export (Tools > Integrations > Administration >
Candidate export > Subscription admin > subscription name > Edit settings > Subscription (tab) > Triggers)

 Remote Recruiter: Select User Types For Remote Recruiter Bulk-Upload (Tools > Remote Recruiter >
Remote Recruiter Settings)

 BrassRing Custom Approval Workflow: BrassRing UserType for System menu (Tools > Custom Approval
Workflow > Actions - Custom Approval Workflow Settings +)

 User type admin preference: functions and related settings for Allow this user type to add/edit the
following user types, Allow the following user types to add/edit this user type, User type admin preference,
Data Insight Tool Access (Tools > Users > User types > Administer type preferences)

How Do Clients Get this Feature?
This feature is available automatically in Workbench without configuration.
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Workbench – Publish Enhancements

This IBM
®

Kenexa
®

BrassRing
®

on Cloud Workbench Publish project is part of an on-going effort to fill in the
gaps of Publish functionality to provide a more streamlined process.

IBM® Kenexa® BrassRing® on Cloud Release 13.4

Feature Areas

LDP 089

 BrassRing Workbench

Visible Changes  No – internal functionality

How do I get this feature?  Automatic when Publish Utility is enabled.

Feature Description
Release 13.4 introduces an improved Workbench Publish User Interface (UI) and the following Publish
enhancements including the ability to publish the following:

HR Status with Talent Gateway Mask

Candidate Forms:

 Enhanced Form Layout
 Auto Fill from Auto fill
 Pop-up form attribute
 Field Help Text

Requisition Enhancements:

 Req templates order of all Standard and Custom Questions
 Field Help Text
 Proximity field creation on req forms with proximity attribute enabled
 Ability to review abridged view of req

Gateway Questionnaire (GQ) settings from various past projects

 Configuring Subset of Options to Display to Candidate Based on a GQ
 Minimize text area size depending on character length
 Candidate Form field response repeat question
 GQ validation message
 View of Completed Application/GQ in Single View Prior to Submission
 Widgets in an active GQ

Talent Gateway Settings

 Social Media Integration for Job Details page
 Customize Send to Friend button label
 Default Site for Candidate Portal Access for non-logged in profiles with matching locale (when enabled for

more than one TG for the same client
 Prevent having more than one TG with the same locale for Default site for WOTC access for non-logged in

profile with matching locale

Communications

 ConditionID with conditional blurbs (includes grouped blurb)
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Who can use this feature?
This feature is available in Workbench for Self-Service Tier 7 and IBM internal use, for client sites with the
(restricted) Publish client setting enabled.
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IBM® Kenexa® BrassRing® on Cloud

Release 13.4 Minor Project Visible Changes

This document includes visible change items (from R13.3 build 1 through R13.4 build 0)
that are not documented individually in the Release 13.4 Product Update Guide.

1. BrassRing - Branding Changes RDP 874

The IBM logo will appear as our new logo, and Kenexa 2x BrassRing and components were
rebranded as IBM® Kenexa® BrassRing® on Cloud.

Following is the list of some BrassRing components/applications and their new names.

 Social Source - IBM® Kenexa® BrassRing® Candidate Relationship Manager, BrassRing
Candidate Relationship Manager

 Event Manager - IBM® Kenexa® BrassRing® Event Manager, BrassRing Event Manager
 Smart Approval - IBM® Kenexa® BrassRing® Custom Approval Workflow, BrassRing

Custom Approval Workflow
 Talent Gateway - IBM® Kenexa® BrassRing® Talent Gateway, BrassRing Talent Gateway.
 RapidHire - IBM® Kenexa® BrassRing® Rapidhire, BM® Kenexa® BrassRing® Talent

Gateway, BrassRing Talent Gateway.
 Remote Recruiter - IBM® Kenexa® BrassRing® Remote Recruiter, BrassRing Remote

Recruiter
 Community Gateway - IBM® Kenexa® BrassRing® Community Gateway, BrassRing

Community Gateway

2. Access to BrassRing Event Manager, BrassRing Custom Approval Workflow, and
BrassRing Community Gateway

As of Release 13.4 Build 0, BrassRing Event Manager, BrassRing Custom Approval Workflow,
and BrassRing Community Gateway are accessible only from within BrassRing. Users need not
separately launch or log in to these applications.

A Close link replaces the Log Off link in BrassRing Event Manager’s navigation menu; click to
close the BrassRing Event Manager window.

3. Reqs – RFA Fields

While editing requisitions in the enhanced Req layout, if a BrassRing user selects the Req Field
Association parent and clicks “Save” even before the RFA could populate the child field, the
values in these fields are lost. To avoid this loss of data, starting this release, the Save button is
disabled until the RFA process is complete and the child field is loaded with a value based on the
selection in the parent field.

4. Requisitions – Posting to LinkedIn

With this release, the “Open Authorization” version used to access LinkedIn is upgraded.
BrassRing users that post jobs on LinkedIn and candidates that use LinkedIn to apply to jobs on
the Talent Gateways will be asked to once again authorize the BrassRing application to access
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their LinkedIn account. This is similar to how they have done the authorization when they
accessed LinkedIn from BrassRing for the first time.

5. Requisitions – Posting to LinkedIn Groups

The feature of posting requisitions to LinkedIn Groups is being shut off with this release. The
ability for candidates to apply with LinkedIn profiles will remain. The ability for recruiters to post
jobs as LinkedIn updates will also remain.

Clients were alerted previously of this contingency: “IBM was recently informed by LinkedIn that
they will no longer allow posting of jobs to LinkedIn groups. As a result, IBM may need to shut off
this feature in the August timeframe. Currently IBM is in discussions with LinkedIn about this
feature to see if we can retain the existing functionality, but wanted to alert customers of this
possibility. The ability for candidates to apply with LinkedIn profiles will remain. The ability for
recruiters to post jobs as LinkedIn updates will remain.”

6. Reqs – Add Job Codes

Starting this release, job codes of requisitions that are in pending status are not listed in the “Add
Job Code” screen for selection. This is to ensure that candidates are not filed to reqs that are still
in pending status.

Before this change: Requisitions of all statuses were available for selection in the list of job
codes. This enabled users to add job codes of pending reqs to candidates there by filing them to
the req even before it is open.

7. Communication Templates – Pop–up Message

Previously, BrassRing would not allow users to delete a Communications template, Document
packet template, nor a System e-mail template if the system detects transactions based on the
template that the user is trying to delete. The transactions (sent email or SMS messages; sent
document packets; sent eLink messages that used a System email template) are always
associated with a candidate and are retained until the candidate is purged.

The pop up message that is displayed when such a deletion attempt is made is now updated to:
Templates associated with communications, documents, and document packets currently
in the system cannot be deleted.

8. Communications – Users Time Zone

BrassRing users receive a confirmation email when they reset their BrassRing account password.
This email contains the date and time when the password reset/recovery was performed. The
time is now displayed along with the correct time zone label.

Background: Previously, though the time in these emails was based on the time zone settings of
the user that sent it, the label of the time zone was always displayed as “Eastern Standard Time”
regardless of the actual time zone that displayed.

9. Processing Icon

A “Please Wait” screen with a spinning wheel image is displayed to users in the some workflows
starting this release. Users click a button to view either a candidate form, or a pdf or any other
screen which might take some time to load. The below screen provides an indication to the users
that the page load is in progress and they have to wait, without which users do not see any
response to the click before the action takes place and may get frustrated.
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Following are the scenarios where the wait screen is displayed:

 View any candidate form from Forms grid including GQ response form or TG form
 Click TG Score (Application score) from Candidate results panel, this will open GQ response

form.
 E-link view forms (check for both GQ response form and any other candidate form).

10. Talent Records – Req ID Information

Starting this build, the requisition information in the Folder/Status dropdown is displayed along
with the requisition ID, instead of the requisition title alone. The Folder/Status dropdown now
displays the requisition in the format of 123BR: Requisition Title.

11. Candidates – Search Criteria

When users perform candidate search, one of the search criteria is number of years of
experience that is calculated based on the input provided in the ‘min’ and ‘max years’ fields. This
is now changed.

Candidate Search page fields now have "Years Experience" instead of "Work Start year.”

Edit Search Fields popup, selection details page, and View Search Criteria now have "Years
Experience”. These fields are to be provided with the number of years instead of calendar year by
the users while performing candidate search. If there are any saved searches based on the Work
Start year fields, updating them with the number of years of experience would fetch results.

12. Candidates – Notes Links

A new hyperlink to download interview to Notes Calendar was previously not available in the
"Send Interview Request" email process. When users accept the interview, they were presented
with a screen which already provides a means to download the interview to Outlook. The new
hyperlink provides similar link for downloading the interview to their Notes Calendars.
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13. Mobile Apply – Field Validation

Previously, the validation of a value entered in the mandatory fields on the ‘Edit’ view of the
‘Profile Contact’ tab was performed when the user clicked either “Save” on the Contact,
Education, or Work tab, or “Submit” on the Education tab.

However, if a required field is empty (not populated with content), validation is performed when
the focus is moved away from the mandatory field. The same approach is now implemented for
validation of entered values in the mandatory fields on the mobile optimized Talent Gateways,
i.e., if the value entered in a mandatory field is not a valid value, then the error message is
displayed when the focus is moved away from the mandatory field.

14. Assessments – New Status Message RDP 1034

There are times when BrassRing has successfully received assessment results for a candidate,
but processing of the results is delayed. Previously in such cases, candidates could believe the
assessment had not been completed, and then attempt to complete the assessment again,
possibly multiple times. As of release 13.4, a new “results processing” status message is
displayed on the Pending Assessment page for candidates in this circumstance. To prevent
repeat attempts to complete the assessment, the link for the assessment that the candidate has
completed is also disabled.

15. Automation Manager – Assessment Trigger

The Scoring Results Automation Manager trigger is no longer available. This option was
removed; a Rules Automation Manager must be used instead.

16. Data Insight Tool – New Thresholds

Previously, in the instances where a Data Insight report takes longer than eighteen hours to
complete, the report is stopped and an automated email is sent to the BrassRing user that ran the
report. In order to handle such scenarios in a better way, new thresholds are being applied. A
corresponding, updated error message is emailed to the users based on the time lines and the
thresholds.

Following are the new thresholds:

Data Insight report Frequency Threshold Time limit
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Daily 4 Hours

Weekly 8 Hours

Monthly 18 Hours

Quarterly 18 Hours

Ad Hoc 10 Hours

When the corresponding threshold frequency is reached, the report is stopped an automated
email is sent to the users with the following message:

“Your Data Insight job, with frequency [frequency], failed to complete within [Number of Hours]
hours, the available reporting timeframe. In order to use this template, it will need to be modified
to reduce the amount of data generated for output. This can be accomplished by removing output
fields, reducing the date range, filtering more concisely, and/or breaking it into multiple templates.
Go to 2xB > Reports > Data Insight Tool > Manage Templates > My Template Library> and select
the Template that you wish to modify.”

17. BrassRing Event Manager – Lock and Unlock Options

The action items Lock and Unlock are now available only when the Enable Candidate
Registration Locking is enabled under the System Scheduling page by selecting “Yes”.
Previously these action options were available even when this condition was set to “No”. With this
release, the error is corrected and the options are available when appropriate condition is
enabled.

18. Event Manager – Instructional Text

In BrassRing Event Manager’s My Schedule page users do not have clear instructions on what
to do in the page. To help users, instructional text is added to let them know how to sign up for
shifts and when to use the Time Zone field.
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19. Event Manager – Candidate Entries

Starting this release, in BrassRing Event Manager when a candidate is invited to an event series,
only one entry is recorded in the candidate's history. Previously, we recorded a separate entry for
each event in the series. All the previous entries that were made for each event in the series will
still be there, but whenever a new invitation is sent, it will now record only one entry.

20. Event Manager – Enhancements

Starting this release, the “Unscheduled Candidates” view and “Scheduled Candidates” view in
BrassRing Event Manager are displayed in grid format with pagination. Users can navigate
through the pages using the pagination provided. They have the option of selecting the number of
records that are displayed per page. Users can also import the records into an Microsoft Excel
file.

The “Unscheduled Candidates” grid can be sorted based on the following columns:

 Name
 Added By
 Date Added
 Requisition
 Last Codes
 Language
 Invited to An Event

Each candidate record can be selected by checking the check box and various actions that are
provided on the page can be performed on the selected records.

21. Event Manager – Assessor Record Enhancement

The existing rule for the Preferred Language field in assessor record is that the options for this
field are all client purchased languages that are supported by BrassRing Event Manager. This
rule leaves some clients unable to add assessors as they use only one language and that
language is not supported by Event Manager.

A new rule is being introduced where the options for the field will now be all client purchased
languages regardless of whether or not Event Manager supports them. The field is used for
reporting purposes as well as to determine the language in which the My Schedule page
(assessor self-scheduling page) displays to assessors who are NOT also BrassRing users.

If an assessor is not a BrassRing user and is configured with a language not supported by Event
Manager, then the My Schedule page will display in the client's default language. If the client's
default language is also not supported by Event Manager, then the My Schedule page will display
in US English.

The remaining existing rules will continue to apply:
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 If an assessor is not a BrassRing user and is configured with a language supported by Event
Manager, then the My Schedule page will display in the language configured for the
assessor.

 If an assessor is a BrassRing user and the user record is configured with a language
supported by Event Manager, then the My Schedule page (and all other Event Manager
pages) will display in the language configured for the user.

 If an assessor is a BrassRing user and the user record is configured with a language not
supported by Event Manager, then the My Schedule page (and all Event Manager other
pages) will display in US English.

22. Recruit and Onboard App (previously 2x Mobile) – Enhancements

The following enhancements were made in the IBM® Kenexa® Recruit and Onboard App scaled-
select UI to ensure similar behavior and screens with BrassRing:

Any scaled-select window in BrassRing with the default search selection as "Contains" now has
the same default search selection for any scaled-select pop up screen in Recruit and Onboard
App (which previously had default option of "Starts."

In BrassRing, when users open a scaled-select window, their earlier selections are retained and
any scaled-select window selections that are submitted are added to the selections on the
previous page. The scaled-select in Recruit and Onboard App now replicates BrassRing scaled-
select behavior. Previously Recruit and Onboard App users’ previous selections were dropped by
the scaled-select function.

23. Recruit and Onboard App – Candidate Exports RDP 760

Recruit and Onboard App is enhanced to support HR status based candidate exports. Users
receive an alert stating that the HR status is updated and an export is triggered based on the HR
status they have updated. The candidate export is completed asynchronously.

24. Recruit and Onboard App – Move/Copy Candidate Forms RDP 759

Starting this release, BrassRing users accessing mobile optimized screens can copy per-req
candidate forms when they are copying or moving candidates from one requisition to another. To
access this feature, users must have the following user type privileges:

 Candidate Actions 2 - Candidates - move/copy to All Reqs (or Candidates – move/copy to My
Reqs)

 Candidate Actions 3 - Candidates - copy per req forms
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Changes Visible to Internal Users

25. Candidate Import – File Name Validation

Validation is added to check the invalid filenames in XML based Candidate Import integrations.
File names with the following special characters are considered invalid:

 /
 \
 :
 *
 ?
 “
 <
 >

Integrations with file names that contains one or more of the above special characters fail.

A new client setting “Copy candidate forms - ignore form field validations” is added in Workbench
Client Settings with Yes or No options. When this setting is set to Yes the field validation is
bypassed. Existing clients will have the setting set to "no" for backward compatibility.

26. Proximity Search – Map Quest Open

Due to recent changes at Map Quest, clients using Map Quest – Open, are required to create a
developer account on Map Quest’s website: http://developer.mapquest.com/web/products/open
and obtain the required key. This is does not require any payments. However, information
regarding the client needs to be provided on the Map Quest website while creating the developer
account.
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Once clients obtain the key, it needs to be inserted in the client settings field “Maps Provider
Key.” After the key is configured and saved in Workbench client settings, Talent Gateways must
be synchronized for the changes to take effect.

27. Integrations – Candidate Import

The Candidate middle name field’s character length was previously restricted to 20 characters in
candidate import integrations. This restriction is now increased to 40 characters based on client
requests as the candidate import integrations were failing for candidates with middle names
longer than 20 characters.

28. Candidate Portal – New Client Setting

A new client setting Candidate Portal – Append expiration date to the links of posted
documents and document packets is added with default value Yes. When this is set to Yes,
the expiration date is appended to all the items [attachments, documents, document packets &
candidate forms] and shown on candidate portal of the Talent Gateway. When this is set to No,
the expiration date is appended to attachments and candidate forms only and not to documents,
document packets on candidate portal of Talent Gateway

Updates to Existing Product Update Guides

These updates will be incorporated into the URC's Searchable Release Notes Tool when that is
next updated with Release 13.4 information.

Feature(s) Update Description

Recruiter Experience – Block
eLinks to Non-System Users
(Release 12.2)

The following limitations were observed in this feature:

e-Linking reqs (to view or edit) is not a part of this project

Social Media – Posting to
Multiple Accounts and
Groups (Release 13.0 RDP
086)

The following limitations were observed in this feature:
The feature of posting requisitions to LinkedIn Groups is being
shut off.
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